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Les logiciels libres et les DRM bientôt incompatibles ?

Actualité

e monde du libre s’agite depuis des 
semaines autour des projets de lois 
cherchant à rendre brevetables les 

logiciels et ceux destinés à restreindre de 
manière drastique l’utilisation de fichiers 
multimédia sur des plates-formes Linux 
ou d’interdire la copie privée illimitée. 
Pour contrer ces dispositions qui n’ont, 
de notre point de vue, que la visée de 
mettre un terme à la diffusion de systè-
mes libres basés sur le noyau Linux et l’ex-
pansion des logiciels libres, une nouvelle 
version de la licence GNU-GPL d’exploi-
tation de ce noyau a été proposée le 16 
janvier par la Free Software Foundation. 
Cette licence largement utilisée, vieille 
de 15 ans pour la version 2, régit l’utilisa-
tion des logiciels libres. Habilement, ses 

auteurs ont introduit des notions qui sont 
censées contrer les clés de protection 
DRM introduites sur les fichiers multimédia 
en téléchargement par la plupart des 
sociétés commerciales telles qu’Apple 
avec ses musiques téléchargeables sur 
iTunes Music Store. 
Le principe de base est d’interdire ces 
sociétés qui proposent du multimédia en 
ligne, payant et protégé par des DRM, 
d’utiliser des logiciels libres pour les ven-
dre. Cette licence interdit ainsi l’usage 
des DRM dans le produit final pour proté-
ger l’utilisateur d’éventuelles poursuites. 
Astucieux.
L’ébauche de cette GPLv3 propose aussi 
que le brevet d’un logiciel est accepta-
ble sous licence GPL dès lors qu’il peut 

être transmis librement et gratuitement 
à quiconque et par quiconque. Ce qui 
reconnaît implicitement l’existence de 
brevets pour les logiciels et en accepte 
donc le principe.
Mais il ne s’agit que d’un brouillon.
Quoi qu’il en soit de la version finale de 
cette nouvelle licence qui ne sera pas 
proposée avant le printemps 2007, le 
«père» de Linux, Linus Torvalds a d’ores et 
déjà exprimé son opposition aux nouvel-
les dispositions de cette licence et sou-
haite conserver les règles de la version 2, 
notamment pour le code du noyau Linux 
dont il est l’auteur. 

www.fsf.org

L

Nouvelle version d’Ubuntu en avril
onformément à sa feuille de route, Canoni-
cal prépare la version 6.04 (pour avril 2006) 
de sa distribution grand public Linux Ubuntu 
(et Kubuntu). Baptisée Dapper Drake, cette 

nouvelle mouture apparue en janvier en version 
alpha ne présente pas encore toutes les fonctions 
définitives ni surtout la stabilité d’un système pleine-
ment opérationnel. Au registre des nouveautés, les 
développeurs annoncent l’intégration du gestion-
naire de fenêtres X11R7 et de Gnome 2.13.4. Quel-
ques détails cosmétiques ont été modifiés comme 
la fenêtre de déconnexion, les bulles d’alerte, etc. 
Les menus ont été revisités pour être toujours plus 
intuitifs.
XChat-Gnome figure au nombre des nouvelles 
applications présentes dans cette distribution qui, 
rappelons-le, ne tient que sur un unique CD. L’autre 
nouveauté concerne le CD-Live avec la possibilité 
désormais de conserver l’état dans lequel se trou-
vait la session lors du précédent arrêt de l’ordina-
teur, et ce par l’entremise d’une simple clé USB. 

https://wiki.ubuntu.com/DapperFlight3

http://cdimage.ubuntu.com/releases/dapper/

http://cdimage.ubuntu.com/releases/

C

ƒ La nouvelle version n’intègre pas que des nouveautés esthétiques, fort heureusement.

Les bulles d’aide
ont un design plus soigné.

ƒ
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Actualité 

Le FAT32 breveté par Microsoft

Nouvelle version d’Ubuntu en avril

ans le n°1 d’Opensource-Maga-
zine (page 3) nous avons évoqué 
l’avis de l’Office américain des 

brevets qui avait décidé de rejeter les 
demandes de Microsoft sur les technolo-
gies de gestion de disques durs : FAT32. 
Utilisée aussi bien par les PC sous Windows 
que par les PC sous Linux, mais aussi dans 
les mémoires flash de certains appareils 
photos numériques et dans certains ba-
ladeurs, cette technologie  risque bel et 
bien d’être limitée dans son utilisation. 
Selon le site Bulletins-Electroniques.com, 
«les examinateurs de brevets ont finale-
ment décidé que deux brevets couvrant 
le système de fichiers FAT (File Allocation 
Table) de Microsoft étaient valides. La 
décision conclut deux ans de procédu-
res et contredit deux avis précédents, 

dans lesquels l’office étasunien des bre-
vets et marques déposées (Patent and 
and Trademark Office - USPTO) avait re-
jeté les demandes de Microsoft.»
Outre la possibilité pour Microsoft de 
réclamer désormais des royalties sur 
tous les appareils formatés par défaut 
au format FAT, les promoteurs de Linux 
pourraient devoir remettre en cause le 
support de ce format dans le noyau du 
système libre. A moins que le monde li-
bre n’accepte de payer des royalties à 
Microsoft ! 

www.bulletins-electroniques.com/
actualites/31599.htm

www.microsoft.com/mscorp/ip/
tech/fat.asp

ariante d’Ubuntu, Edubuntu est 
proposée fort logiquement en 
version 5.10 dans la foulée de 

la sortie de la mise à jour de la distribu-
tion Linux sud-africaine à la popularité 
grandissante.
Edubuntu est une version spécialement 
adaptée au monde l’éducation. Le CD 
d’installation n’est disponible que pour 
les architectures PC (i386 et AMD 64 
bits).
Il n’existe pas encore de disque « live » 
ni de support en français de cette dis-
tribution. 

www.edubuntu.org/

www.scideralle.org/

D V

Edubuntu
pour les écoles

buntu compte parmi les distributions Linux les plus 
simples à mettre en œuvre, les moins encombran-
tes (un CD suffit) et les plus aisées à utiliser. Loin 

d’être minimaliste, Ubuntu (et sa déclinaison sous KDE, 
Kubuntu) méritait bien qu’on lui consacre un ouvrage. 
C’est Eyrolles qui s’y colle. L’éditeur très présent sur le 
créneau des logiciels libres a fait appel à Benoît Cac-
cinolo, Lionel Dricot et Joyce Markoll pour rédiger un 
guide qui ravira les nouveaux venus, d’où qu’il viennent.  
« Pas de problème. Le but de ce livre est de vous per-

mettre d’apprendre 
à utiliser Ubuntu au 
moins aussi bien, si 
pas mieux, que votre 
Windows ou votre sys-
tème actuel. Le livre 
explique autant que 
possible les concepts 

abordés et se tourne résolument vers un public non-
technique et souhaitant utiliser son ordinateur dans un 
cadre bureautique », écrit Lionel Dricot à propos de son 
livre « Ubuntu, Une distribution Linux facile à utiliser ».

Prix : 25 €

Site de Lionel Dricot :
http://ploum.frimouvy.org/?2006/01/06/

88-ubuntu-le-livre

Pour en savoir plus :
www.framasoft.net/article4275.html

Pour commander :
www.eyrolles.com/Accueil/Livre/9782212116083/

Non content de proposer un ouvrage
pour les débutant, Eyrolles, via Campus Press
édite aussi un livre consacré au même sujet
«Ubuntu Linux» par Michael Kofler (37 €). 

Deux livres
consacrés à Ubuntu

U

elais indispensable du magazine papier, le site internet 
Opensource-Magazine s’enrichit chaque jour des interven-
tions des lecteurs dans la section du forum de discussions. 

A votre tour vous pouvez lire les avis, les suggestions et les astuces 
des lecteurs internautes en consultant les rubriques «La vie du ma-
gazine», «Vos trucs et astuces», «Aidez-vous les uns les autres», «Foire 
aux questions», «Les sommaires du magazine», «l’Agenda». 
En vous inscrivant vous pourrez de surcroît intervenir à votre tour 
dans ce forum et poser des questions si vous rencontrez un souci ou 
si vous voulez en savoir plus sur le magazine.
Notez que depuis le site Opensource-Magazine.com il est égale-
ment possible de s’abonner (paiement en ligne par CB, sécurisé) 
ou de commander un ancien numéro.
Le site dispose aussi d’une rubrique Graticiels qui répertorie quel-
ques uns de vos logiciels favoris. Il est également possible depuis 
le site, outre la consultation des sommaires des numéros parus et à 
paraître, de rechercher le sujet et la date de parution d’un article 
sur un sujet donné en entrant un mot dans le moteur de recher-
che. 

www.opensource-magazine.com

Le site pour prolonger le plaisir

R

ƒ Le site du bimestriel
       OpenSource Magazine
       permet de ne pas perdre
       le contact entre
       deux numéros.



Actualité

Scribus porté sous Windows
erminé le passage par l’émula-
tion Cygwin pour faire tourner 
Scribus (cf Opensource-Magazine 

n°1 page 43 et suivantes) sous Windows 
(XP et 2000 SP4, ne fonctionne pas sous 
98 et ME). La nouvelle version 1.3.2 pro-
posée depuis la fin du mois de janvier 
fonctionne désormais en natif grâce à 
Qt3 dans l’environnement de Microsoft. 
Scribus, également disponible en version 
1.3.2 sous Mac OS X en natif ou par l’en-
tremise de Fink est un logiciel de publica-
tion assisté par ordinateur (PAO) gérant 
parfaitement le PDF ainsi que la chaîne 
des couleurs. 
Au registre des nouveautés apportées 
par cette version 1.3.2 outre le support 
natif de Windows, Scribus propose le 
support des informations EXIF contenues 
dans les fichiers d’images Jpeg et amé-
liore le support des formats Tiff et PSD 
d’Adobe Photoshop. Près de 300 bugs 
ont également été corrigés.

• Scribus pour Windows :
http://windows.scribus.net/

Téléchargez et installez Ghostscript puis 
cliquez sur le lien Download Scribus. Dans 

la page qui suit, cliquez sur : scribus-132-
win32-install.exe, cliquez sur un des liens 
Download de la page suivante et lancez 
cet exécutable une fois téléchargé. 

• Scribus pour Mac :
http://aqua.scribus.net/

Télécharger les éléments suivants :

- Scribus-Aqua-1.3.2-2006-01-23.tar.bz2 
(30 MB)
- Libraries-A-2006-01-23.tar.bz2 (4.4 MB)
- Libraries-B-2005-10-09.tar.bz2 (784 KB)

Décompressez ces éléments. Vous obte-
nez d’une part l’application Scribus pro-
prement dite et deux dossiers Libraries (A 
et B) contenant des éléments divers et 
variés. Ces éléments doivent être dépla-
cés dans un dossier nommé Frameworks 
dans votre Bibliothèque. Si ce dossier 
n’existe pas, créez-le.

Sans doute sera-t-il aussi judicieux d’ins-
taller Ghostscript sous Mac. L’élément 
à ajouter au dossier Frameworks est té-
léchargeable depuis la même page à 
la rubrique Older Downloads. Il faudra 
ensuite redéfinir le chemin vers l’exécu-
table Ghostscript dans les Préférences 
de Scribus (/Library/Frameworks/Ghosts-
cript.framework/bin/gsc).

• Scribus pour Linux :
www.scribus.org.uk (rubrique Download)

Scribus est disponible avec Synaptic ou 
Adept. Vous pouvez aussi vous aventurer 
à recompiler les sources. 

T

ƒ Scribus démarre sous Windows sans Cygwin.

Ubuntu ne s’installe plus sur Mac !

Si vous avez acquis le dernier né des ateliers Apple, 
l’iMac Intel, vous rencontrerez quelques déboires à 
l’heure d’installer une distribution Linux. Il n’est pour 
l’instant pas possible de le faire. Certes, cela ne saurait 
tarder. Il est même heureux de constater qu’en adop-
tant un processeur Intel (Yonah dual-core), Apple va 
permettre aux utilisateurs de profiter plus largement 
encore des logiciels libres. Les versions PowerPC de 
la plupart des logiciels libres sont en effet plus rares et 
souvent plus anciennes. Du coup, les développeurs 
devraient rencontrer moins de difficultés pour porter 
leur production sur toutes les plates-formes. A moins 
qu’Apple ne décide vraiment de brider ses machines.
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Képi, le grand gourou

La Gendarmerie nationale poursuit sa migration vers les 
solutions libres. Franchement en pointe dans ce domaine, 
après avoir adopté la suite bureautique OpenOffice.org au 
détriment de celle de Microsoft, la voici qui adopte partout 
le navigateur internet Firefox. Ce navigateur internet de la 
fondation Mozilla qui détient désormais 20 % de part de mar-
ché, présente sur ses concurrents (Safari d’Apple, Internet Ex-
plorer de Microsoft) un meilleur respect des standards W3C.

Linux Party spéciale éducation

La 10e Linux Party aura lieu samedi 25 mars à Nantes (de 
11 heures à 18 heures) avec pour thème central, l’édu-
cation). Une Linux party est une journée gratuite ouverte 
à tous les publics pour présenter les logiciels libres. Durant 
ce samedi la salle de l’Olympic sera transformée en cen-
tre mulitmédia. 
Quatre pôles de démonstration seront accessibles : multi-
média, bureautique et internet, technique et jeux.
Pour de plus amples infos, contactez l’associaiton Linux 
Nantes . 

www.linux-nantes.org

Thunderbird évolue

Après Firefox (cf OSM n° 1), 
c’est au tour de Thunderbird, le 
client mail de la fondation Mo-
zilla, de passer en version 1.5. 
Cette nouvelle version intègre 
des solutions anti-spam mais 
aussi anti-pishing (escroquerie 
par mail) ainsi que la gestion 
des flux RSS et du podcasting. 
Comme Firefox, Thunderbird est 
désormais dotée d’un système de mise à jour simplifié qui télé-
charge ce dont il a besoin en arrière plan. Thunderbird vérifie 
l’orthographe à la volée et sauvegarde automatiquement les 
messages en cours de rédaction. Il est enfin possible de suppri-
mer les pièces jointes des messages en réception.

Pour Windows, Mac OS X et Linux.  www.mozilla-europe.org



Courriers

Pour le moment j’adore ce nouveau magazine. J’ai acheté le 
1 et 2 et je trouve que les articles sont intéressants. Il serait bon 
d’avoir des articles un peu plus approfondis parfois mais dans l’en-
semble on va à l’essentiel et si on veut chercher plus loin Google 
est notre ami.
La qualité du papier et la rédaction sont très bonnes. 
Pas de CD ni DVD pour l’achat en presse mais je trouve ça bon 
dans le sens où 4 euros pour le magazine c’est tout de suite plus 
intéressant que certains magazines avec DVD à 7/8 euros... Et les 
4/5 des personnes visées pour ce type de magazine ont Internet je 
pense.
Par contre pour les personnes abonnées il serait intéressant d’avoir 
un CD ou DVD bonus de temps à autre   

Ah oui aussi pas de PUB ca c’est extra continuez comme ça ... 
Si les moyens financiers ne gênent pas trop, en tout cas je pense 
m’abonner pour le n° 3.
Bon courage pour la suite à vous tous ! Hypnoz (forum Opensour-
ce-Magazine)

Opensource-Magazine : Chaque abonné a droit à un CD d’instal-
lation d’Ubuntu pour Mac ou PC, il suffit d’en faire la demande sur 
le bulletin d’abonnement.

Je pense que ça serait bien de mettre un 
aperçu du numéro suivant, c’est à dire des 
gros titres que l’on pourra lire dans ce pro-
chain numéro, ça donnerait un avant goût 
aux lecteurs et ça pourrait inciter d’autres 
personnes à acheter le magazine s’ils y trou-
vent des articles intéressants.
Perry-Rhodan (forum Opensource-Magazine)

Opensource-Magazine : Le sommaire du n° 3 
est affiché sur le site depuis près d’un mois. 
Nous afficherons le sommaire du n° 4 égale-
ment plusieurs semaines avant parution à la 
fois sur le site et dans ce forum. Les abonnés 
seront également avisés par mail.

Cela faisait longtemps que je lisais des articles sur les logiciels 
libres ou open source sans néanmoins franchir le pas quoique 
utilisant OpenOffice, Gimp, etc (tout en autodidacte comme 
l’informatique d’ailleurs). Car en effet dès que l’on s’y penche 
un peu, des kyrielles de manip sous Dos ou autres, des termes 
amphigouriques, des expressions ou mode d’emploi en anglais 
rebutent facilement. 
Et c’est grâce aux deux numéros d’Opensource-Magazine 
(Osmag) que je viens de faire mes premiers pas dans ce sens en 
installant sur mon PC Cygwin puis Scribus sans trop de soucis. Mes 
premières impressions sont bonnes mais les tâtonnements sont 
encore de rigueur. Cela démontre bien que le but de vulgariser 
(de populariser, c’est mieux) le libre, choisi par la rédaction de la 
revue, est atteint ou du moins en bonne voie. 
Tout ça pour dire que Osmag me plaît beaucoup : mise en 
page, prix, articles simples et compréhensibles pour des débu-
tants comme moi (quoique encore peut être un peu superficiels : 
mais ce n’est que le n° 2). 
J’espère que l’équipe éditoriale poursuivra dans ce sens en 
veillant à rester toujours simple (pour attirer plus de monde vers le 
libre et donc vers la revue) et en utilisant un maximum de mate-
riels et de logiciels en français svp, por favor).
Sinon je ne m’abonne pas à partir du n°3 - non c’est une blague, 
Je m’abonne dès la parution du prochain Osmag. 
Pour en finir avec Scribus, une question (car encore absent sur le 
forum de la revue) comment imprimer depuis Scribus et existe-t-il 
un moyen pour remonter d’un niveau dans l’arborescence des 
dossiers : je ne peux aller plus avant que /home/gobois/ ? 
Allez bon courage à toute l’équipe et à bientôt dans les forums. 
Gobois (forum Opensource-Magazine)

Opensource-Magazine (Alex) : On va commencer par l’arbores-
cence. 
Pour enregistrer ailleurs que dans le «/home/nomducompte» il 
suffit de le remplacer par «c:/» et remonter là où on veut. 
Par exemple chez moi ce sera «c:/Documents and Settings/Ad-
ministrator/Desktop» pour l’avoir sur mon bureau. 
Et en effet, pour pouvoir imprimer directement depuis Scribus 
cela n’a pas l’air de marcher. 
Il faut donc enregistrer son travail, puis aller dans le menu Fichier 
/ Exporter / Enregistrer en PDF. 
Ensuite il sera tout à fait possible d’imprimer. 

Je vous écris pour savoir s’il est possible 
d’utiliser une distribution de Linux avec KDE 
sur Mac, mais en LiveCD. Et aussi si il est 
possible de copier le contenu théorique d’un 
LiveCD sur une partition en ext3 du Mac pour 
éventuellement ne pas avoir à faire l’installa-
tion soi-même (ardue quand même).
Si oui, quelles distributions le permettent ?
Nail Lazrak

Opensource-Magazine : La distribution sur CD 
live et CD d’installation de Kubuntu (dérivé 
d’Ubuntu) est faite pour vous. Vous aurez 
quelques informations sur Kubuntu dans ce 
numéro. Quant aux images de CD pour gra-
ver une version live ou pour installer Kubuntu 
à demeure, il suffit de se rendre sur le site 
dédié au sujet :
www.kubuntu.org (section download)

J’ai votre magazine n° 1 et j’ai voulu essayer 
Qemu (note: je suis un débutant sous Linux, 
mais j’ai suivi vos instructions le plus à la lettre 
possible tout en modifiant ce qu’il fallait du 
fait de ma configuration).

A peine deux lignes après l’instruction, ça me 
dit : « Pas possible de trouver l’adresse DNS ».
Avec Ubuntu 5.10 mais aussi la même chose 
avec : Knoppix 3.6 et Mandriva 2006
Il n’y a que sous Windows que j’ai réussi à 
installer un systèmre virtuel avec Qemu
ce qui, vous l’avouerez, est plutôt déprimant. 
Aurais-je fait une erreur impardonnable (in-
formatiquement parlant) ?
Je serai heureux que vous puissiez m’éclairer
et vous en remercie d’avance. Phil

Opensource-Magazine : Pour que Qemu dé-
marre, il faut tout bonnement que votre PC 
soit branché à un réseau et dispose d’une 
adresse IP à moins d’utiliser l’option «-net 
none» au lancement. Connectez votre ordi-
nateur à internet, lancez le processus Qemu 
et vous devriez pouvoir conclure l’installation.
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OpenOffice
éflexe pavlovien, à chaque fois qu’un ancien utilisa-
teur de Windows passe à un autre système, il panique 
terriblement à l’idée soudaine qu’il ne pourrait plus 

avoir sur sa nouvelle machine Word, Excel, PowerPoint, bref, 
tout l’attirail de la suite Office de Microsoft. Comme chacun 
sait, en pareille situation, il ne faut paniquer. 
Il existe une suite concurrente, libre et open-source, ap-
pelée OpenOffice.or ou OOo. Cette suite est loin d’être 
quantité négligeable. Bien au contraire. Elle équipe de 
plus en plus d’établissements et administrations publiques 
soucieuses, croyez-le, de nous faire faire des économies. On 
ne peut qu’applaudir.
OpenOffice.org propose, à l’image de sa concurrente 
commerciale, un solide traitement de texte, néanmoins 
dépourvu de correction grammaticale, un tableur aussi 
performant qu’Excel, un système de création de présenta-
tion (équivalent à PowerPoint) et des capacités à créer et à 
gérer des bases de données.

Avec la version 2.0 désormais disponible, OpenOffice.org 
a fait un grand pas vers une plus grande convivialité et 
surtout, une meilleure prise en main. 
Le logiciel se compose de plusieurs sections :

> Création d’un document texte
> Création d’une feuille de calculs
> Mode présentation (diaporama)
> Dessin vectoriel (mise en page sommaire)
> Base de données

OOo propose aussi la création de document HTML wysiwyg 
(ce que vous voyez est ce que vous aurez), c’est-à-dire qu’il 
est inutile de connaître le langage en question pour créer 
des pages web dignes de ce nom.

OOo offre un module de saisie de formules mathématiques 
permettant de visualiser les formules dans le respect des 
normes.
OOo intègre aussi des fonctions de création d’étiquettes ou 
de cartes de visite.

Dans tous les cas, OOo peut aller puiser dans une base 
de données que vous avez créée, des informations et les 
ajouter à des formulaires composés par vos soins afin de 
les personnaliser. Voici un exemple qui vous permettra de 
saisir le fonctionnement des bases de données et du mode 
dessin.

• Sous Linux : OpenOffice.org est désormais systématique-
ment livré avec toute nouvelle distribution Linux, sauf excep-
tion. La suite est généralement accessible depuis le menu 
Applications > Bureautique sous la forme de ses modules 
indépendants (Base, Calc, Draw, Impress, Math, Writer). 
Synaptic permet d’installer cette suite sans souci.

• Sous Mac : pour installer ce logiciel, il faut que l’utilitaire 
X11 soit présent dans les Utilitaires (dossier Applications>Utilit
aires) de Mac OS X. Il existe une alternative codée en Java 
qui ne nécessite pas X11 : NeoOffice. 

• Sous Windows : La nouvelle version nécessite au moins 
Windows 98. Pour lancer le module d’installation, cliquez sur 
Ooo_2.xxWin32Intel_install_fr.exe.

http://fr.openoffice.org/

en anglais :

www.openoffice.org/

NeoOffice, l’alternative autonome pour Mac OS X

l existe une alternative à OOo sous Mac OS X : NeoOffice. 
Ecrite en java, cette suite bureautique est disponible en 
français. La version 1.1 est sortie en novembre 2005, pre-

mière version officielle de NeoOffice/J, est basée sur la ver-
sion stable d’OpenOffice 1.1.5, ce qui n’est pas de la toute 
première fraîcheur. L’un des avantages de cette variante 
par rapport à OOo c’est sa meilleure intégration au système 
MacOS X. Ainsi, la fermeture du dernier document ne quitte 
pas l’application contrairement à ce qui se passe avec OpenOffice. NeoOffice 
présente un aspect Aqua plus supportable aux yeux des Macmaniaques puisqu’il 
utile la barre classique des menus pour les principales commandes. NeoOffice 
présente l’inconvénient d’être lent au démarrage. 

Système : s’installe à partir de Mac OS X 10.2 > 10.4
Le fichier à télécharger pèse 120 Mo (livré avec les sources)

et prendra 330 Mo sur votre disque dur au final.
NeoOffice est gratuit.

www.planamesa.com/neojava/fr/

I
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OpenOffice
penOffice.org est une application 
entièrement autonome qui ne ré-
clame aucun programme supplé-

mentaire sous Windows, contrairement à 
Mac qui necessite X11. Voici donc le pro-
cessus d’installation à suivre pour votre 
PC.  Tout d’abord, rendez-vous sur le site  
http://fr.openoffice.org» ou plus précisé-
ment sur cette page  http://download.
openoffice.org/2.0.1/index.html. Sélec-
tionnez dans le menu déroulant «select 
your language», la langue française, 
autrement dit: «French». Ceci vous amè-
ne sur une autre page où vous cliquez 
sur «Continue to download». Là, vous sé-
lectionnez le serveur et téléchargez les 
77Mo de la suite bureautique.

Une fois le téléchargement effectué, fai-
tes un double-clic sur l’icône (OOo_2.0.1) 
présente sur votre bureau. Une fenêtre 
s’ouvre vous remerciant d’avoir télé-
chargé Ooo. Cliquez sur «Suivant».
Par défaut, la décompression des fichiers 
se fera dans un dossier placé sur votre 
bureau. Vous pouvez toutefois modifier 
son emplacement. Il suffira ensuite de cli-
quer sur «Décompresser». Une barre vous 
indiquera l’état de la décompression et 
une fois terminée une nouvelle fenêtre 
s’ouvrira.

Cette nouvelle fenêtre est celle de 
l’installation définitive. Un message de 
bienvenue vous accueille au démar-
rage et vous poursuivez en cliquant sur 
«Suivant». Comme presque tous logiciels, 
il est nécessaire d’accepter la licence. 
Une fois l’accord donné, cliquez sur «Sui-
vant». Dans la rubrique qui apparaît et 
mentionne «nom de l’utilisateur», entrez 
votre nom. Si vous êtes seul à utiliser vo-
tre ordinateur, cochez la mention qui se 
trouve en bas «installer ce programme 
pour l’utilisateur en cours uniquement». 
Dans le cas où plusieurs personnes l’utili-
sent, il est préférable de laisser en l’état. 

Puis vient le choix entre une installation 
standard et une installation personnali-
sée. Si vous n’avez pas forcément besoin 
de l’intégralité du programme proposé 
par Ooo, faites une installation personna-
lisée en sélectionnant ce dont vous avez 
besoin comme, par exemple, le traite-
ment de texte, le tableur, la base de don-
nées, etc… Par contre, le plus simple est 
de faire une installation de tout ce qui est 
offert. Cliquez sur «Suivant».  OOo vous 
propose d’ouvrir tout document éma-
nant de Word, Excel, Power Point, etc. Si 
vous ne possédez aucun logiciel Micro-
soft, laissez coché et cliquez sur « Instal-

ler ». Quelques minutes de patience et 
vous pourrez enfin cliquer sur «Terminer» 
pour clore cette installation. 

S’agissant d’une première utilisation, lan-
cez n’importe quelle application trouvée 
du menu Démarrer/programmes/Ope-
nOffice.org 2.0.
Une fenêtre s’ouvre pour vous informer 
que vous allez être guidé sur les prochai-
nes étapes. Un clic sur «Suivant». Accep-
tation de la licence : dans cette partie, 
faites défiler la barre de côté jusqu’en 
bas ou bien cliquez sur le bouton en 
bas «Faire défiler» qui permet l’accès au 
bouton «Accepter». Entrez votre Nom, 
Prénom, et vos Initiales. Cependant tout 
ceci est facultatif. Il ne tient qu’à vous de 
mentionner ce que vous voulez entrer. 
Un clic sur Suivant. Il vous est proposé de 
vous enregistrer sur le site d’OpenOffice.
org afin de recevoir les informations sur 
les nouveautés et autres produits. A vous 
de déterminer votre choix en cliquant la 
case appropriée.
 
Un dernier clic sur « Terminer » et vous 
voici à même d’utiliser cette excellente 
suite bureautique.

Alx.

ƒCliquez sur le bouton «Suivant» pour passer
       d'un panneau à un autre.

ƒ Renseignez le champ utiisateur avant d'aller 
       plus loin.

ƒGrâce au menu, choisissez le module d'OOo
       que vous souhaitez utiliser.

ƒ L'enregistrement est factultatif.
OpenOffice.org permet de réaliser
des documents illustrés de qualité.

ƒ
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ne fois OpenOffice.org version 
2.0 lancé, une page de traite-
ment de texte s’ouvre générale-

ment par défaut. Commencez par fer-
mer cette page en déroulant le menu 
Fichier>Fermer (File>Close) (Image 1). 
Puis, toujours depuis le menu Fichier, allez 
sur Nouveau>Dessin (New>Drawing) pour 
ouvrir une page de dessin vectoriel. 
Si vous souhaitez travailler sur plusieurs 
pages, utilisez le menu Insertion>Diapo 
(Insert>Slide) (image 2), une nouvelle 
page s’ajoutera à la suite. En l’agrip-
pant avec le pointeur de la souris, vous 
pouvez déplacer cette page où vous le 
souhaitez dans la colonne de gauche et 
modifier ainsi l’ordre des pages.
Si vous désirez travailler non pas en mode 
portrait (page verticale) mais en mode 
paysage (page horizontale), utilisez le 

menu Format>Page et cochez le bou-
ton Orientation (image 3) permettant de 
passer d’un mode à l’autre. 

A présent que vous êtes prêt, nous allons 
créer un bloc texte qui pourra être per-
sonnalisé. Dans la barre des outils située 
en bas, cliquez sur le bouton T et tirez 
avec le pointeur de la souris dans la page 
blanche pour créer un bloc (image 4).
Vous pouvez directement écrire dans ce 
bloc ou copier/coller un texte provenant 
d’un autre logiciel. Notez que la com-
mande Pomme-V pour coller est rempla-
cée par CTRL-V. De même pour copier, 
il faut combiner les touches CTRL-C et 
pour annuler : CTRL-Z.
Lorsque le bloc contient le texte vous 
pouvez modifier l’aspect du cadre en 
utilisant l’outil Flèche présente à l’extrê-

me gauche dans la barre du bas. Pla-
cez-vous sur les points de couleur verte 
pour redimensionner le bloc d’un côté et 
de l’autre. 
Pour ajouter une couleur de fond, cliquez 
sur le bloc pour l’activer et sélectionnez 
une couleur dans la barre supérieure des 
outils (image 5).  La couleur des caractè-
res peut également être modifiée en va-
lidant cette fois tout (CTRL-A) ou partie 
du texte (avec le pointeur de la souris). 
Enfin, vous pouvez aussi ajouter un cadre 
de couleur différente à ce bloc en utili-
sant les outils Style de ligne et Largeur de 
ligne situé à gauche de la barre d’outils 
supérieure.  

L’insertion d’une image dans ce docu-
ment peut se faire par glisser/déposer 
(non fonctionnel dans la version Mac 

U

image 1

image 2

image 3 image 4
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image 5

image 6

image 7

OS X) ou par l’outil « A partir d’un fichier » 
(From file) situé dans la barre inférieure 
(icône formée d’un rond jaune, d’un 
triangle bleu et d’un carré rouge). 

Notez que, contrairement à une page 
de traitement de texte classique, le bloc 
texte et le bloc image sont indépendants, 
ce qui signifie que vous ne pouvez pas in-
sérer l’image dans le texte (image 6) en 
faisant glisser le contenu du texte autour 
de l’image (image 7).

Cette fonction est en revanche possible 
dans un Document texte, après avoir cli-
qué sur l’image ajoutée, depuis le menu 
Format>Adaptation du texte>Renvoi 
relatif à la page (Format>Wrap>Page 
Wrap) (ou autre choix selon ce que vous 
recherchez). 

Pour redimensionner de manière ho-
mothétique une image ou un bloc 
quelconque(conserver les mêmes pro-
portions horizontales et verticales), ap-
puyez sur la touche Majuscule lors du 
changement de taille à l’aide du poin-
teur de la souris. 

Chaque bloc peut être déplacé sur la 
page mais peut aussi être placé der-
rière ou à l’avant d’un autre objet. Uti-
lisez les outils Disposition (Arrange), Ali-
gnement (Alignment) disponibles dans 
la barre d’outils inférieure. Vous pouvez 
aussi associer plusieurs objets en un seul. 
En appuyant sur la touche Majuscule, 
cliquez sur un bloc, puis sur un autre 
(voire un 3e, etc) et déroulez le menu 
Modifier>Grouper. Vous pourrez faire ma-
chine arrière avec la fonction Dissocier 

de ce même menu. Une fois groupés, 
les blocs sont considérés comme un seul 
objet.

Outre les images et les textes, il est possi-
ble de dessiner des formes (carrés, traits, 
courbes de Bezier, rectangles, symboles, 
flèches, connecteurs, ronds...) avec les 
outils disponibles dans la barre inférieu-
re. 

Les documents réalisés en dessin vecto-
riel peuvent être exportés en différents 
formats dont le SVG qui est exploita-
ble par Inkscape, Scribus, The Gimp et 
même par Adobe Illustrator. Le PDF est 
évidemment supporté ainsi que le RTF 
et le HTML, ce qui, dans ce dernier cas, 
peut s’avérer bien pratique pour créer 
de jolies pages web.

OpenOffice.org

Créer une première publication avec OpenOffice

Créer et gérer une base de données avec OOo
a nouveauté marquante de cette version 2.0 d’OpenOf-
fice.org est la possibilité de créer des bases de données 
autonomes compatibles avec les standards du genre. 

Voici un pas à pas pour créer sa première de données.

Lancez OOo et sélectionnez depuis le menu Ficher>Nouveau le 
module Base de données (File>New>Database). La nouveauté 
de la version 2, outre la possibilité de se connecter à des bases 
existantes de différents types (Microsoft Access, MySQL, OBDC, 
dBase, etc) en cochant la case du premier panneau (en bas), 
est de pouvoir créer des bases autonomes. Il suffit de cocher la 
case « Créer une base de données » (Create a new database) 
puis de cliquer sur le bouton Suivant (image 1). 
Dans le deuxième panneau, ne modifiez aucune des deux op-
tions et cliquez sur Terminer (image 2). 
Dans le troisième panneau, nommez votre base de données, 
sélectionnez l’endroit où vous souhaitez l’enregistrer, et cliquez 
sur Enregistrer (image 3).

image 1
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Une page s’ouvre dans laquelle vous allez pouvoir créer des 
champs, entrer des données, et générer des formulaires.

Acte 1 : Nous al-
lons créer des 
champs pour en-
trer l’identité de 
nos abonnés. Ces 
champs auront 
pour appellation : 
nom, prenom, 
adresse, code-
postal, ville. Cli-
quez en haut à 
gauche sur l’outil 
Tables (image 4), 
puis dans la co-
lonne centrale sur 
« Créer une table 
en mode Ebau-
che » (Create Ta-
ble in Design View). Une page marquée de nombreuses lignes 
s’affiche. Entrez le nom du premier champ dans la première 
case. Aussitôt, dans la colonne adjacente s’affiche la mention 
Texte[VARCHAR]. Ce qui signifie que ce champ recevra des 
caractères de tous types (alphanumériques). A moins que vous 
ne souhaitiez modifier cette donnée en déroulant le menu 
contextuel, passez votre chemin et inscrivez le deuxième nom 
de champ au-dessous du premier, etc.
Cliquez enfin sur l’outil disquette en haut à gauche pour enregis-
trer la Table 1 (vous pouvez changer son nom). Après avoir va-
lidé, on vous signale qu’il faut créer une clé primaire (image 5). 
Acceptez cette proposition en cliquant sur Oui. Un nouveau 
champ « ID Integer[INTEGER] » est créé. Cliquez sur la ligne ID 
puis, dans la partie inférieure de la fenêtre, modifiez AutoVa-

leur (Auto Value) 
en sélectionnant 
Oui au lieu de 
Non. Ainsi chaque 
fiche créée ulté-
rieurement sera 
numérotée auto-
matiquement à sa 
création. Fermez 
le fenêtre. 
La structure de vo-
tre base de don-
nées est créée. 
Si vous double-cli-
quez sur la ligne 
Table1, vous allez 
ouvrir votre base 
en mode saisie, 
c’est-à-dire que 
vous allez pou-
voir enregistrer les 
données qui cor-
respondent à chaque champ (image 6). Notez que le champ 
ID s’incrémente à chaque fois d’une nuité (si vous avez bien 
réglé Auto Valeur). 
Si vous souhaitez ajouter des champs, combinez les touches 
Pomme-Clic (ou clic-droit) sur la ligne Table1 pour la Modifier 
(image 7).

Acte 2 : Il est temps de créer un environnement plus agréa-
ble pour travailler avec la base. Il s’agit à présent de créer un 
Formulaire (Forms). Cliquez à gauche sur cet outil puis en haut 
sur «Créer un Formulaire en mode Ebauche » (Create Form 
in Design View). Une page blanche s’ouvre. Depuis le menu 
Affichage>Barre d’outils>Contrôles de formulaires affichez la 
palette des outils de Formulaire si elle n’est déjà présente à 
l’écran. Dans cette palette, sélectionnez l’outil « Zone de tex-

OpenOffice.org

image 2

image 3

image 4

image 5

image 6

image 7

OpenSource Magazine / n° 3 / mars-avril 200610

Linux§ Windows§ Mac§



te » et dessinez dans la page, un rectangle (image 8). 
Combinez la touche Pomme et clic (ou clic du bouton droit) 
pour afficher un menu contextuel dans lequel vous sélection-
nez la ligne Formulaire (image 9) ceci afin d’afficher le pan-

neau qui permet de sélectionner la source de Contenu, en 
l’occurrence, la Table1 dans notre exemple. Une fois que vous 
avez sélectionné la Table1 comme source où aller rechercher 
les données à afficher dans le rectangle, il faut définir de quel 
champ le contenu sera affiché dans ce rectangle. Pour ce fai-
re, double-cliquez sur le rectangle pour afficher un autre pan-
neau qui permet de sélectionner le champ de données dans 
la liste (image 10). 

Créez ainsi autant de zones de texte (Text Box) que vous sou-
haitez afficher de champs. Vous pouvez commenter votre 
formulaire en ajoutant des champs d’étiquettes (Label Field). 
Pour voir ce que donne le résultat, cliquez sur l’outil de la palet-

te « (Des)Activer le mode conception » (Design Mode on/off). 
Lorsque le mode Conception est désactivé, vous pouvez affi-
cher les données de chaque fiche et même les modifier (ima-
ge 11). Mieux encore, vous pouvez ainsi ajouter de nouvelles 
fiches en cliquant sur l’outil Nouvel enregistrement situé tout en 
bas de la fenêtre et en supprimer avec l’outil Supprimer l’en-
registrement.

Acte 3 : Créer un bouton. Vous pouvez ajouter des boutons à 
votre formulaire qui auront pour fonction de déclencher des 
actions précises.  En mode Conception, dessinez un bouton 
depuis l’outil Bouton de la palette. Une fois le bouton dessiné, 
double-cliquez dessus et dans le panneau, à l’onglet général, 
sélectionnez une Action à associer à ce bouton lorsqu’il sera 
pressé, par exemple Nouvel enregistrement (image 12). A cha-
que fois que vous cliquerez sur le bouton, une nouvelle fiche 
sera créée.

Acte 4 : Pour chercher des fiches, vous pouvez vous contenter 
de l’outil Loupe situé en bas à gauche dans la barre des outils 
(image 13). Lorsque vous serez plus aguerri avec cet outil, vous 
pourrez créer des requêtes nettement plus complexes.     

OpenOffice.org

image 8

image 9

image 10

image 11

image 12

image 13
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Application internet

N ombreux sont ceux qui pétochent 
sec lorsqu’ils ne disposent plus de 
Word de Microsoft pour rédiger 

leurs petites œuvres littéraires.
Sur Mac comme sous Windows ou Linux il 
existe pourtant une foule de solutions al-
ternatives déjà décrites dans nos colon-
nes. Les traitements de texte Abiword et 
OpenOffice sont parfaits pour se dispen-
ser de l’usine à gaz microsoftienne.
Il existe une autre solution, c’est d’utiliser 
un traitement de texte en ligne compati-
ble avec Word. Il n’est plus nécessaire de 
se prendre le chou pour installer quelque 
logiciel que ce soit, tout se passe avec 
Writely par l’entremise d’un simple navi-
gateur internet.
Du coup, la plate-forme informatique 
importe peu. Writely accessible en ligne 
permet de créer des documents au for-
mat Word, OpenOffice, RTF, etc.

La seule et unique contrainte est de 
créer un compte gratuit (cliquez sur Sign 
up!) pour pouvoir utiliser ce traitement 
de texte en ligne accessible de n’impor-
te quel endroit. Pour créer un compte, 
une adresse mail suffit. Inventez-vous 
un mot de passe, cliquez sur Register et 
c’est parti ! 
L’inconvénient majeur est que ce ser-
vice n’est pas encore proposé en fran-
çais. Mais il n’y a que quelques boutons 
à comprendre pour pouvoir se servir de 
cet outil.
Le premier à assimiler est le bouton New 
situé tout en haut de la page. Il permet 
de créer un nouveau document. Lors-
que vous cliquez dessus, Writely vous de-
mande de donner un nom à ce nouveau 
document.

Quelques instants plus tard, une feuille 
de saisie caractéristique d’un traitement 
de texte s’affiche dans votre navigateur 
internet. Vous pouvez alors saisir votre 
texte et le mettre en forme avec les outils 

proposés dans la barre su-
périeure. Il y a tout l’attirail 
pour changer la police, le 
corps, la couleur, pour pu-
blier au format HTML, pour 
ajouter des liens, etc. Les 
outils d’interlignage et de 
chasse sont absents.

Une fois votre texte com-
posé, vous pouvez le sau-
vegarder sur le serveur Wri-
tely en cliquant sur l’icône 
de disquette ou imprimer 
votre œuvre depuis l’icô-
ne d’imprimante.
Pour récupérer ce texte 

dans votre ordinateur au format Word 

(ou OpenOffice, RTF, PDF, etc.) dérou-
lez le menu Actions. Notez que ce menu 
permet aussi de gérer les documents 
(effacer, copier, renommer, compter les 
mots, etc.). 
Une fois que vous avez choisi d’enre-
gistrer le document au format Word, il 
s’enregistre sur votre disque. Word de Mi-
crosoft, mais aussi OpenOffice, Abiword 
etc., réussiront à ouvrir les documents 
.doc ainsi créés.
À l’inverse, vous pouvez éditer du texte 
avec Writely en utilisant la commande 
Upload. Vous pouvez de la sorte ouvrir un 
document Word (.doc) ou autre sans for-
cément posséder d’application adap-
tée. La compatibilité semble toutefois 
limitée à la version Word de 1998...

http://www.writely.com/

writely
le traitement de texte en ligne

Trois outils
sont à connaître

dont New qui permet
de créer un nouveau

document.

ƒDonnez 
un nom
au nouveau 
document.

ƒCliquez sur «Sign Up» pour vous créer un compte. 

ƒ Pour créer un compte, saisissez votre mail
        et un mot de passe quelconque.

ƒ Il est possible d'ajouter
         les liens hypertexte.

ƒ L'outil Actions permet,
         entre autres, de sauver
         votre texte.

ƒ

Geneweb
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Application web

Geneweb
Pour les passionnés de généalogie

es amateurs de gé-
néalogie sont nom-
breux, aussi bien 

sous Linux que sous Mac 
OS ou Windows. 
L’écueil de la plupart 
des applications pro-
posées pour ces plates-
formes est qu’elles sont 
payantes.
Il existe aussi des solu-
tions libres comme Ge-
neWeb, logiciel conçu 
par Daniel de Rauglau-
dre (INRIA). Nettement 
moins aguichante sur le 
plan esthétique, la solu-
tion GeneWeb a le mé-
rite d’être accessible à 
tous les amateurs de gé-
néalogie d’autant plus qu’elle est dispo-
nible en français.
Une fois GeneWeb installé avec Synaptic, 
il est nécessaire de lancer la procédure 
par la création d’une base de données 
vide. Et il faut en passer par le Terminal 
en entrant la commande :
gwc -o mabase

où «mabase» est la base vide.

Une fois cette opération effectuée, en-
trez la commande :
gwd -blang

Cette commande sert à lancer Ge-
neweb et à ouvrir la page dans la langue 
utilisée par votre navigateur (français). Il 
se peut, au passage, que le logiciel soit 
déjà en route. Peu importe. Ouvrez une 

page vierge de navigateur internet et 
entrez l’adresse :
127.0.0.1:2317

où 2317 est le port par défaut utilisé par 
Geneweb (ce peut être aussi : local-
host:2317). Pour en changer, il aurait fallu 
entrer :
gwd -p <numero-du-port>

Notez qu’il faut laisser le terminal ouvert 
avec la commande «gwd» active pour 
pouvoir utiliser l’environnement Ge-
neweb depuis le navigateur internet. 
Pour arrêter la session, combinez les tou-
ches CTRL-C depuis le terminal.
Dans la page qui s’est affichée, vous ne 
pouvez que saisir le nom de votre base 
créée depuis le terminal : mabase et 

valider par le bouton OK. Notez que le 
lien direct vers votre base sera doréna-
vant :
127.0.0.1:2317/mabase

un lien que vous pouvez conserver dans 
vos signets pour gagner du temps par la 
suite.
A partir de cette base, vous pouvez 
ajouter une famille (en cliquant sur Ajou-
ter une famille) et consulter les données 
déjà entrées.
L’un des intérêts majeurs de GenWeb est 
que la base peut être mise en ligne et 
qu’elle peut même provenir d’un logi-
ciel respectant la norme GEDCOM. Ge-
neweb utilise des techniques de calcul 
de parenté et de consanguinité répu-
tés pour leur efficacité et mise au point 
avec l’aide de Didier Rémy, directeur 
de recherche à l’INRIA (Institut national 

de recherche en 
informatique). Il n’y 
a pas de limite pour 
la taille d’une base. 
Des bases plus gros-
ses vont simplement 
consommer plus de 
mémoire.
GeneWeb, logiciel 
libre avec Licence 
GNU, est disponible 
pour Unix, Windows 
et Mac (OS X).

ƒAprès avoir créé une base vide au Terminal,
       vous pouvez y accéder avec GeneWeb.

ƒAjouter une nouvelle famille ne présente
aucune difficulté.

http://cristal.inria.fr/~ddr/GeneWeb/

ƒ Le moteur de recherche offre un grand nombre
       de possibilités de tri. ƒ L'affichage est austère mais les informations ont le mérite d'être clairement répertoriées.

L

OpenSource Magazine / n° 3 / mars-avril 2006 13

Linux§ Windows§ Mac§



Application web

our la gestion des notes des 
élèves en collèges ou lycées, 
les solutions libres existent. Aux 

côtés des incontournables solutions 
commerciales, Pronote (et ProfNotes) 
disponible pour Windows, Notabene 
pour Windows uniquement et Cam-
pus (Windows et Linux), existe la solu-
tion libre Gepi. 

Gratuite, cette solution nécessite un 
minimum de maîtrise de l’outil infor-
matique. Elle a le grand mérite de 
fonctionner sur tous les ordinateurs, 
qu’ils soient équipés de Windows 
(c’est-à-dire les machines payées 
avec nos sous par les Conseils géné-
raux, donateurs officiels de Microsoft), 
de Linux (en progression grâce à la 
bonne volonté de certaines acadé-
mies) ou de Mac (quasiment disparu 
du secteur scolaire en France). 

Car Gepi (Gestion des Elèves Par In-
ternet) fonctionne depuis n’importe 
quel navigateur internet et s’appuie 
sur les technologies PHP, MySQL et 
Apache. C’est d’ailleurs la seule dif-
ficulté. 

La première chose à faire est de se 
procurer l’ensemble Gepi. Une fois 
téléchargé depuis le site de ses dé-
veloppeurs, décompressez l’archive 
pour obtenir un répertoire que vous 
vous bornerez à glisser dans le dos-
sier du Système de répertoire : var > 
www.

Puis, lancez un navigateur et entrez 
l’adresse :

http://localhost/gepi:
ou
127.0.0.1/gepi

A la première connexion, Gepi de-
mande d’Installer la base MySQL. Cli-
quez pour tout simplement connecter 
Gepi à MySQL. Il va de soi que le ser-
veur Apache, MySQL et PHP doivent 
avoir été installés au préalable (cf 
Opensource-Magazine n°2 p.21).

Entrez l’identifiant de connexion au 
serveur MySQL (root par défaut) et le 
mot de passe défini avec PhpMyAd-
min (aucun par défaut). Précisez 

ƒGlissez le répertoire Gepi
       dans le dossier var > www

ƒ En cas de problème d'accès, modifiez
       les autorisations du fichier Secure.

ƒ Jusque là, tout va bien.

ƒ Entrez l'identifiant de votre serveur
       MySQL.

ƒ Une fois l'adresse 127.0.0.1/GEPI validée,
       cliquez sur le lien d'installation de la base.

1

2

3

4

5
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Application web

Pronotes : www.indexeducation.com/fr/

NotaBene : www.omt.fr

Campus : www.laureats.com/dossiers/produits/campus/campus/campus.asp

Logiciels de gestion des notes : www.crdp-montpellier.fr/cd48/tice/colleges/gestion_notes.htm

Gepi : http://gepi.mutualibre.org/ 

http://gepi.mutualibre.org/download.php

l’adresse de la base de données en 
ajoutant le port comme suit :

localhost
ou
127.0.0.1

Il est possible que vous tombiez sur 
un message d’erreur dès le départ, 
après avoir tenté de vous connecter 
«Installer la base MySQL». Un message 
indique que vous avez des problèmes 
de droit d’accès avec un répertoire 
/secure inaccessible en écriture. Pour 
résoudre ce souci, ouvrez le dossier 
var > www > gepi puis cliquez sur se-
cure en appuyant sur le bouton droit 
de la souris pour pouvoir sélectionner 
les Propriétés du dossier dans le menu 
contextuel. Dans le panneau des Per-
missions, cochez la case Ecriture pour 
Autres. 

Selon toute vraisemblance, vous réus-
sirez ensuite à passer le test et un mes-
sage de succès s’affichera en vous 
donnant de surcroît la liste des bases 
locales disponibles. Celle qui vous in-
téresse est bien sûr la base « gepi ». 
Quelques secondes suffisent pour 
créer la structure de la base. La der-
nière étape consiste à se connecter 
à la base que vous venez de créer. 
Notez qu’un nom de connexion et 
un mot de passe vous seront deman-
dés. Il s’agit respectivement de : ad-
min et de azerty. Lors de la première 
connexion, on vous sollicitera pour 
changer le mot de passe. Ne vous fai-
tes pas prier.
Ensuite, cliquez sur Gestion des bases 
pour créer les bases relatives à cha-
que établissement, à chaque classe, 
à chaque élève, à chaque utilisateur, 
etc. Le site internet Gepi donne des 
informations pour réussir à prendre en 
main cette puissante solution de ges-
tion et de suivi des résultats scolaires. 
Gepi peut être accessible via le ré-
seau par tous les acteurs de l’établis-
sement. De la saisie des résultats de 
chaque évaluation par les professeurs 
à l’impression des bulletins au service 
scolarité, en passant par la prépara-
tion des conseils de classe, Gepi est 
un outil souple et facile d’accès. Sur-
tout, il est gratuit.

ƒ Jusque là, tout va bien.

ƒ Entrez l'identifiant de votre serveur
       MySQL.

ƒ Sélectionnez la nouvelle base 
       Gepi ou créez-en une autre.

ƒ La structure de la base
       est créée.

ƒ Il ne reste plus qu'à se connecter
       à la base Gepi.

ƒ Par défaut,
       utilisez « admin »
       et « azerty ».

ƒDéterminez
       un nouveau mot
       de passe avant
       de vous mettre
       au travail.

6

7

8

9

10
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Application web

omment créer facilement une 
nouvelle base de données et en 
gérer tout aussi aisément le conte-

nu ?
Il est possible d’utiliser des outils comme 
PHPmyAdmin pas forcément limpides. 
Il existe une autre solution qui permet de 
s’affranchir des prises de tête avec PHP-
myAdmin : Eskuel. 
« Eskuel est une administration de base 
de données MySQL écrite en PHP. Elle 
permet de gérer entièrement et sim-
plement une ou plusieurs bases sans 

connaissances particulières 
en SQL.
« À la manière de phpMyAd-
min, Eskuel permet de récu-
pérer les propriétés d’une 
table, d’exporter et importer 
la structure et/ou le contenu 
d’une base de données. Vous 
pourrez ajouter, supprimer 
un ou des enregistrements, 
contrôler et optimiser la taille 
d’une table ou d’une base, 
renommer ou copier des 
données, bref tout ce que 
phpMyAdmin sait faire mais 
en mieux et plus fonctionnel » 
expliquent les auteurs de cet-
te astucieuse solution. 
Un peu plus souple et clair 
que PHPmyAdmin, Eskuel 
fonctionne sur toutes les pla-
tes-formes, quel que soit le 
système d’exploitation utilisé.
Pour mettre en route Eskuel, 
déplacez le dossier « eskuel » 
dans le dossier « www » qui se trouve à 
l’intérieur du répertoire var de votre sys-
tème de fichiers (ou enregistrez-le sur le 
serveur FTP de votre fournisseur d’ac-
cès).
 
Lancez un navigateur et entrez
l’adresse :

http:localhost/eskuel:
ou
127.0.0.1/eskuel

pour une utilisation locale ou bien :

www.votrenomdesiteperso/eskuel

pour une utilisation depuis internet.

A la première connexion, une page de 
mise en service est affichée. Après avoir 
sélectionné votre langue, il vous est de-
mandé les coordonnées de connexion 
au serveur MySQL. 
L’hôte sera : localhom (ou 127.0.0.1) en 
local
L’utilisateur sera : root (par défaut)
Le mot de passe sera : rien si vous n’avez 
pas affecté de mot de passe avec php-
MyAdminilors de la mise en route de vo-
tre serveur MySQL (cf Opensource-Ma-
gazine n°2 p.21 et suivantes).
Le nom de la configuration est sans im-
portance.

Une fois ces données validées, Eskuel 
vous gratifiera d’un message de félicita-
tions. 

C
Gérer plus facilement vos bases MySQL

•Entrez les coordonnées de votre serveur MySQL. 

•Dans Eskuel, tout se passe dans le menu situé à droite. 

•Modifiez
les propriétés 
pour
enregistrer la 
confirmation. 

•Clic-droit sur le dossier Eskuel donne 
accès aux propriétés. 
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Si ce n’est pas le cas et qu’il affiche un 
message d’impossibilité de copier la 
nouvelle configuration dans le fichier 
config.inc.php, il faut modifier les pro-
priétés du dossier Eskuel en donnant les 
autorisations d’écriture à Autres.
Lorsque la configuration est correcte-
ment enregistrée, Eskuel affiche les féli-
citations tant attendues.
Une fois que vous avez cliqué sur le lien
« Retour à eskuel » vous pouvez travailler. 
Vous devrez commencer par créer une 
Base (bouton à droite), puis, une ou 
plusieurs tables qui constitueront cette 
base, etc. La création des bases se pi-
lote depuis le panneau de droite où les 
diverses options s’affichent au fur et à 
mesure. 

Attention, n’employez pas de lettres ac-
centuées ou de caractères spéciaux en 
nommant une nouvelle base ou 
une nouvelle table.

www.phptools4u.com/scripts/
eskuel/?lang=francais

http://eskuel.com

•Il ne vous plus qu’à saisir 
les données correspondant 

à chacun des champs 
définis.
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• Une fois la table créée,
la liste des commandes 

s’allonge. Elles permettent 
d’ajouter et de gérer

le contenu de chaque table.

• Une fois une nouvelle base créée, lancez-vous dans 
la création d’une table avec ses différents champs 

(quatre dans cet exemple)­.
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Audio

anshee est un lecteur audio grâce 
auquel vous pouvez importer, gé-
rer et jouer des fichiers de votre 

collection de musique. Reprenant le de-
sign d’iTunes d’Apple (uniquement com-
patible Mac OS X et Windows), Banshee 
réagit de surcroît comme le lecteur de 
la firme à la pomme en proposant d’ex-
plorer l’ordinateur pour importer les musi-
ques qui s’y trouvent.

Tous les morceaux seront classés dans 
une bibliothèque principale. De là, il 
sera possible de créer de nouvelles listes 
de lecture depuis le menu Music > New 
playlist. Les Préférences permettent de 
définir l’emplacement de la bibliothè-
que où sont stockés les morceaux, l’en-
codeur est limité, par défaut aux formats 
Ogg Vorbis, Wave/PCM et Flac.

Il va de soi que Banshee est capable 
d’importer les morceaux d’un CD dont il 
va rechercher automatiquement les ré-
férences sur internet pour en afficher le 
nom des pistes. Il est aussi capable de 
se synchroniser avec un iPod. Il est aussi 
possible de graver un CD audio depuis 
Banshee. 

La nouvelle version de Banshee apporte 
son lot d’améliorations et de nouvel-
les fonctions notamment le partage de 
musique en réseau. La version 0.10.4 de 
janvier 2006 est disponible et nécessite 
l’installation préalable de :

Mono 1.1.10 ou plus
Gtk# 2.4 (2.3.92 ou plus)
HAL 0.5.2 ou plus
D-Bus 0.36.2 (and dbus-sharp) or better
GStreamer 0.8.11 or GStreamer 0.10 (ex-
perimental)
libmusicbrainz 2.1.1 or better
libnautilus-burn 2.12 or better
GTK+ 2.6 or better (2.8 recommended)
sqlite3 libraries

Banshee peut aussi être installé avec Sy-
naptic ou Adept mais il ne s’agira sans 
doute pas de la version la plus récente. 
Si vous avez des soucis de lecture de fi-
chiers, essayez d’installer avec Synaptic 
le paquet Gstreamer-plugins qui contient 
tous les plug-ins nécessaires. 

http://banshee-project.org/

ƒ  La fenêtre pr incipale de Banshee est t rès inspirée du fameux iTunes d’Apple
      Banshee gère les morceaux Ogg Vorbis et WAV par défaut
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ême sous Linux, vous 
n’échapperez pas à la 
mode du podcasting dé-
mocratisé par Apple avec 

son lecteur multimédia, iTunes, dispo-
nible sur Windows et Mac OS X, mais 
absent du monde libre. Dans le n°2 
d’Opensource-Magazine nous avons 
vu qu’il était possible d’acheter de 
la musique sur l’iTunes Music Store 
depuis Linux. Dans le n°1 nous avons 
décrit divers outils pour lire les fichiers 
audio.
Voici aujourd’hui iPodder qui permet, 
une fois installé avec Synaptic, de té-
lécharger légalement des émissions 
audio et vidéo, des extraits de films, 
des clips musicaux, etc. iPodder est 
un logiciel qui remplace sous Linux 
mais aussi sous Mac OS X et Windows 
le fameux iTunes d’Apple.

Une fois iPodder installé, commencez 
par enregistrer une adresse d’un po-
dcast de votre choix (voir ci-contre) 
en cliquant sur le bouton vert marqué 
d’un signe +. Entrez l’URL du podcast 
que vous souhaitez exploiter. Aussitôt 
que l’adresse a été validée, la liste 
des émissions disponibles est mise à 
jour et s’affiche. Il ne reste plus qu’à 
faire son marché en cochant les épi-
sodes désirés.
Une fois la liste de vos courses établie, 
cliquez sur le bouton bleu marqué 

d’un triangle pointé vers le bas. Le té-
léchargement des éléments cochés 
commencera. Tous les fichiers iront 
s’enregistrer dans le dossier Down-
loads du répertoire iPodderData situé 
dans votre répertoire personnel. Le 
rangement s’effectue par adresses 
URL, un dossier étant affecté à cha-
cune.
Vous trouverez des fichiers multimédia 
dans ces dossiers et vous pourrez les 
lire avec gXine ou VLC (cf Opensour-
ce-Magazine n°1 p.32) pour peu que 
vous les installiez à leur tour...
Normalement iPodder est suscepti-
ble de lire directement les émissions 
audio avec le lecteur multimédia 
Xmms, mais cette fonction nous a pa-
rue perfectible. 

Audio

M
Télécharger des émissions audio et vidéos...

Essayer :

www.gaumont.fr/pod/dvd.xml
http://feeds.feedburner.com/SongOfTheDay
www.allocine.fr/video/podcast.xml

voir aussi l’annuaire :

http://francepodcast.viabloga.com/

Commencez par ajouter l'adresse d'un podcast
pour télécharger de nouvelles missions.

iPoder est 
développé par 

Linux, cce qui 
n'exclut pas de 

récompenser ses 
développeurs.

Une fois téléchargés, vous pouvez écouter les fichiers avec
un lecteur multimédia classique.
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ous Windows comme sous Mac 
OS X il est possible de profiter 
d’émissions de radio ou de pro-

grammes vidéo s’appuyant sur la tech-
nologie développée par RealNetworks. 
Il existe pour Linux deux solutions per-
mettant d’écouter de tels fichiers : Real-
Player et Helix. Helix-Player est disponible 
depuis Synaptic mais peut être, à l’instar 
de RealPlayer, directement téléchargé 
depuis le site des développeurs. 
Si vous utilisez une distribution Debian 
(Ubuntu notamment) vous pouvez récu-
pérer les paquets .deb sur le site debian.
org et les installer avec la commande :

sudo dpkg -i <paquet.deb>

Quel que soit votre système Linux, si vous 
souhaitez installer Helix ou RealPlayer 
sans passer par Synaptic, téléchargez la 
dernière version de l’«Installer» du lecteur 
de votre choix en version Linux/PPC ou 
Linux/x86. Vous devez obtenir un fichier 
au suffixe .bin. Entrez la commande :

chmod +x 

dans le terminal et glissez à la suite le fi-
chier .bin.
L’icône de ce fichier sera modifiée.
Glissez-la à nouveau vers une fenêtre de 
terminal sans autre commande et vali-
dez. Le processus d’installation démarre. 

Ne vous souciez pas des 
questions, validez à cha-
que fois avec la touche 
Entrée. 
Lorsque RealPlayer est 
installé, vous pouvez jouer 
les fichiers .ram chargés 
depuis les sites proposant 
des programmes multi-
média en 
ligne (la Ra-
dio Suisse Ro-
mande par 
e x e m p l e ) 
simplement 
en les glis-
sant sur une 
fenêtre de 
Rea lP laye r 
ou en utili-
sant le bou-
ton droit de 
la souris pour 
cliquer sur 
l’icône du fi-
chier .ram et 
sélectionner 
dans le menu contextuel le lecteur Real-
Player.
Le lecteur Helix qui se télécharge depuis 
la même page, peut s’installer exacte-
ment de la même manière.

A l’usage, le lecteur RealPlayer s’avère 
plus efficace que le lecteur 
opensource Helix. Reste que 
nous avons eu bien des diffi-
cultés à lire un fichier vidéo.

Exemples avec Radio suisse romande :  

www.rsr.ch

Téléchargement :

http://player.helixcommunity.org

Audio/Vidéo

S

RealPlayer et Helix
Le multimédia internet à votre portée

Glissez le 
fichier .ram 
sur la fenêtre 
du lecteur.

Essayez le programme de la Radio suisse romande pour vous faire une idée.

Veillez à installer la version correspondant
à votre matériel.

Helix semble moins fonctionnel que RealPlayer.
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RealPlayer et Helix
Logiciel

bcde n’a pas la vocation à rem-
placer les outils classiques d’im-
portation de pistes audio. Loin 

s’en faut. D’autant qu’il n’est ni plus pra-
tique, ni plus convivial.
Mais si vous souhaitez disposer d’un uti-
litaire capable d’extraire les musiques 
d’un CD au format WAV puis de les 
convertir au format OGG Vorbis (par dé-
faut) ou MP3, ce logiciel open-source 
peut vous être utile. Une fois installé avec 
Synaptic, Abcde peut être appelé de-
puis une fenêtre de Terminal par la sim-
ple commande :

abcde -k

Veillez à avoir introduit au préalable un 
CD audio pour qu’il puisse fonctionner 
correctement. L’option -k permet de 
conserver le fichier original au format 
WAV. 
L’option -o mp3 permet d’encoder non 
pas en Ogg Vorbis mais en MP3 à la 
condition d’avoir installé depuis Synaptic 
l’utilitaire id3v2 et lame.
Les fichiers sont stockés dans le répertoi-
re personnel dans un dossier Abcde. Ils 

seront enregistrés et convertis provisoire-
ment dans le dossier abcde puis seront 
emmagasinés dans un dossier du nom 
de l’artiste détecté sur CDDB si vous étiez 
connecté à internet. 
Sinon, le dossier de stockage final sera
« Unknow Artist » (artiste inconnu).

Si vous ne trouvez pas Lame, vous pou-
vez le télécharger ici : 

www.mp3machine.com/software/lame_
mp3/download.shtml
ou
http://sourceforge.net/project/
showfiles.php?group_id=290

Comment installer Lame ?

Décompressez l’archive lame.tar.
Ouvrez une fenêtre de terminal, tapez 
CD et glissez à la suite le dossier lame dé-
compressé.

Tapez la commande :

./configure

patientez quelques instants,

puis tapez la commande :

make

et enfin, au terme des travaux de
compilation, la commande :

sudo make install

Indiquez votre mot de passe en aveugle 
(les caractères ne s’affichent pas) et le 
tour est joué.

www.mp3dev.org/mp3/

A

Abcde peut 
convertir au 
format MP3, 
et VLC peut 
relire ces 
fichiers.

L’outil d’extraction et de conversion des pistes d’un CD audio

• Insérez le CD 
audio, entrez la 

commande : abcde, 
puis, laissez agir 

quelques minutes.
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isponible depuis 
longtemps sous 
Linux, le logiciel 
éducatif GCom-

pris a été porté plus 
récemment sous Win-
dows. Cette dernière 
version est payante 
(20 €) contrairement 
à la version libre qui 
peut être installée sous 
Linux via Synaptic ou 
Adept. GCompris est 
également disponible 
sous Mac OS X, via 
Fink (uniquement sous 
Jaguar).
Sous Linux, l’applica-
tion se lance depuis 
le menu des Applica-
tions 

> Jeux > Suite éducative GCompris

GCompris est un logiciel éducatif qui 
propose des activités variées aux enfants 
de 2 à 10 ans.

Les activités sont quelques fois ludiques, 
mais toujours pédagogiques.
Vous trouverez des activités dans les do-
maines suivants :

- découverte de l’ordinateur : clavier, 
souris, les mouvements de la souris, ... 
- mathématiques : révision des tables, 

dénombrement, les tables à double en-
trée, symétrie, ... 
- sciences : l’écluse, le cycle de l’eau, le 
sous-marin, ... 
- géographie : placer les pays sur une 
carte 
- jeux : des casses têtes, les échecs, le 
memory, ... 
- lecture : exercice d’entraînement à la 
lecture 
- autres : lecture de l’heure, peintures cé-
lèbres sous forme de puzzle, dessin vec-
toriel, ...

GCompris propose plus de 70 activités 
et ses développeurs poursuivent l’inté-
gration de nouvelles. GCompris est un 
logiciel libre, il vous est donc possible de 
l’adapter à votre besoin ou de l’amélio-
rer, et pourquoi pas, d’en faire bénéficier 
les enfants du monde entier.

Les activités de GCompris sont inéga-
les et parfois déroutantes, notamment 
les labyrinthes en 3D qui mériteraient un 
meilleur traitement des textures pour évi-
ter de se trouver devant un écran blanc 
qui laisse perplexe.
L’exploration permet heureusement de 
trouver quelques jolies perles pédagogi-
ques. 

http://gcompris.net/-fr-

Logiciel

D

GCompris
Logiciel éducatif, ludique aussi, parfois

Les 
développeurs 
ont à l'évidence 
consacré 
moins de temps 
au portage 
du panneau 
d'administration 
dans notre 
langue.

Les 70 activités proposées ont vocation à être pédagogiques, sans 
négliger la notion de plaisir indispensable à l'apprentissage.

OpenSource Magazine / n° 3 / mars-avril 200622

Linux§ Windows§ Mac§

Mac, Linux ou Windows : Abiword est disponibles sur 
toutes les plates-formes



Linux§ Windows§ Mac§

P lusieurs logiciels de gestion de 
comptes bancaires personnels sont 
disponibles sous Linux (mais aussi 

sous Mac OS X et Windows) en version 
libre, open-source la plupart du temps. 
De bonne facture, ils ont pour nom Gnu-
Cash, Grisbi ou encore KMyMoney. Si la 
solution française Grisbi a notre préféren-
ce pour sa parfaite intégration à l’envi-
ronnement Gnome (cf Opensource-Ma-
gazine n°1 p.51) et sa facilité d’utilisation, 
KMyMoney pourrait mieux convaincre 
les utilisateurs de Linux sous environne-
ment KDE.
Disponible par Synaptic ou Adept, KMy-
Money n’est pas aussi facile à prendre 
en main que Grisbi, notamment en rai-
son d’un portage en français très perfec-
tible. 
Au lancement (depuis Applications > 
Bureautique > Kmymoney), le logiciel 
propose plusieurs options, en anglais 
[image1].
Set up a new KMyMoney data file : 
permet de créer une base qui abritera 
les comptes.
Use an existing KMyMoney data file : 
ouvre un une base de comptes existan-
te.

En cliquant sur le premier 
choix, vous allez pouvoir dé-
cliner votre identité en dé-
tail puis sélectionner votre 
monnaie [image2]. Ne vous 
méprenez pas, la France 
est associée avec le franc ! 
Il faut sélectionner la ligne 
Euro pour utiliser la monnaie 
courante dans cette zone et valider par 
le bouton se trouvant en bas de la liste.
Sélectionnez ensuite le répertoire «tem-
plates» fr-FR puis Comptes_par_defaut.
kmt et enfin cliquez sur OK.

Vous revenez au panneau d’accueil où il 
ne se passe pas grand chose si ce n’est 
que la mention «Afficher la page de 
bienvenue de KMyMoney». 
Cliquez à présent sur l’outil disquette de 
la barre des outils du logiciel pour enre-
gistrer vos coordonnées. 
Pour créer votre compte personnel dé-
roulez le menu Compte > Ajouter un nou-
veau compte. Sélectionnez une banque 
ou ajoutez-la si elle ne figure pas dans la 
liste. Dans le panneau suivant, vous pou-
vez rester sur le choix Checking pour un 
compte courant classique (chèque, CB, 

virements, etc), donnez 
un nom au compte et 
éventuellement son nu-
méro et enfin le solde lors 
de sa création.
Une fois que vous serez 
dans votre compte, il 
suffira d’utiliser les outils 
en onglets situés au pied 
de la fenêtre pour gérer 
vos entrées et sorties de 
fonds. 

A vous de vous faire la main. Mais 
KMyMoney est de notre point de vue 
sensiblement moins convivial que Grisbi 
qui a le mérite d’être disponible sur tou-
tes les plates-formes.
http://kmymoney2.sourceforge.net/

image 1

image 2

• Sélectionnez la ligne Euro plutôt que Franc.

• Ajoutez vos comptes à la base de départ.

• Les principales 
commandes
pour gérer vos comptes
se trouvent en pied
de fenêtre.
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AMP, autrement dit 
Windows Apache 
MySQL et PHP, peut 
être considéré com-

me le trio gagnant pour créer 
et gérer ses bases de données 
ou encore, tester ses sites in-
ternet en local avant de les 
diffuser sur le réseau.

Wamp est un seul et unique lo-
giciel, dont la seule opération 
consistera à le télécharger et 
l’installer sur votre PC équipé 
du système Windows.  Vous le 
trouverez à ce lien:

ht tp ://www.wampserver .
com/download.php (18.3MB)
Lorsque l’exécutable, c’est-
à-dire la version « wamp5_
1.6.1.exe », sera téléchargé 
sur le bureau, double cliquez 
sur son icône pour faire appa-
raître le message de bienve-
nue. Cliquez sur « Next » puis acceptez 
la licence en cochant « I accept the 
agreement » et finalisez par un nouveau 
clic sur « Next ».

Il vous est alors proposé d’installer le dos-
sier sous : « C:\wamp ».

Si cela vous convient, cliquez sur « Next » 
sinon déterminez l’emplacement que 
vous souhaitez lui donner.

Puis vous aurez la création d’un raccour-
ci dans le menu « Démarrer » et encore 
un clic sur « Next » pour faire apparaître 

la fenêtre suivante. Celle qui s’affiche 
alors, vous propose, si vous le souhaitez, 
de lancer automatiquement WAMP5 
au démarrage de votre ordinateur. En 
ce qui nous concerne, nous avons opté 
pour ce choix de configuration. Encore 
un clic sur « Next » et vous avez le récapi-
tulatif des opérations effectuées jusqu’à 
ce point. Pour confirmer votre accord, il 
ne vous reste plus qu’à cliquer et à pro-
céder à l’installation de WAMP5 grâce à 
« Install ».

Vous pourrez suivre le processus avec la 

barre verte qui s’affiche et se déroule 
sous vos yeux.

Un nouvelle fenêtre s’ouvre afin de pro-
céder au choix de votre dossier « Docu-
mentRoot ». Il s’agit du dossier dans lequel 
vous allez pouvoir stocker vos sites web 
ou vos pages en PHP. Sa sélection se fait 
par défaut dans le sous-dossier « www » 
qui se trouve dans « wamp ». Si cela vous 
convient, il ne vous reste plus qu’à cliquer 
sur « Ok ». D’ailleurs, il vaut mieux conser-
ver ce choix. Une autre fenêtre vous de-
mande quel est le navigateur de votre 
choix. Par défaut, vous aurez «explorer.
exe ». Mais notre préférence se porte sur 
Mozilla Firefox que nous allons récupérer 

W

Image 2 : Sélectionnez votre navigateur (Firefox, IE, Netscape, etc...). Image 3 : Laissez coché «Launch WAMP5 now».

Image 1 : Gardez l’emplacement par défaut pour le dossier 
«www».

Image 4 : Cliquez sur le compteur
pour accéder au menu.

Installer un serveur Apache, MySDL et PHP sous Windows

Wamp
Section Windows
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dans notre dossier des programmes. Il est 
bien évident que le choix du navigateur 
vous appartient entièrement et libre à 
vous de conserver Internet Explorer ou 
d’en choisir un autre. 

Le choix étant maintenant fait, cliquez sur 
« Ok ». L’installation est sur le point de se 
terminer. Laissez coché « Launch WAMP5 
now » et cliquez sur « Finish ». Ce point 
final envoie le démarrage de WAMP et 
dans la barre des menus, sur la droite, 

s’affiche une nouvelle 
icône blanche en forme 
de compteur. Un simple 
clic sur cette icône vous fait apparaître 
un menu qui vous propose d’accéder 
aux différentes pages telles que Local-
host, phpMyAdmin et SQLiteManager.

Vous y verrez aussi le dossier «www direc-
tory», le fichier des logs (Log files), les Ser-
vices pour Apache et MySQL, etc. Portez 
en premier votre choix sur « Localhost ». 

Il va ouvrir le navigateur que 
vous avez sélectionné, (pour 
nous, Mozilla Firefox) et fait 
également apparaître les 
informations liées à Wamp5. 
Vous pourrez constater qu’il 
s’agit d’une version anglaise 
que nous vous proposons de 
modifier en version française, 
tout simplement en la sélec-
tionnant par un clic en haut 
à droite (Version 1.6.1 - ver-
sion française). Pour en reve-
nir à Localhost, vous aurez sur 
cette page la configuration 
du serveur avec la version 
Apache, ainsi que celle de 
PHP et de MySQL. Vous avez 

aussi dans les outils proposés des liens cli-
quables avec phpinfo(), phpMyAdmin et 
SQLitemanager. Vous pouvez cliquer sur 
ces liens si l’envie vous prend.

Et en dernier s’affiche « vos projets ». 
D’ailleurs, il vous affichera « Aucun pro-
jet», car c’est à vous de placer vos créa-
tions dans le répertoire « www ». Souve-
nez-vous qu’au début de l’installation, 
WAMP vous a proposé l’emplacement 
du dossier «DocumentRoot ».

Nous avons gardé cette proposition par 
défaut (C:\Wamp\www) et nous y avons 
placé un dossier sous la dénomination 
«Test OPEN SOURCE Magazine». 

 Ainsi en rechargeant la page de votre 
navigateur, vous aurez l’icône du dos-
sier «Test OPEN SOURCE Magazine» dans 
la section « Vos Projets ».  En cliquant sur 
celui-ci, vous atteindrez directement le 
contenu du site et pourrez donc tester 
vos pages en PHP.

Alx.

Image 9 : SQLiteManager est aussi disponible.

Image 7 : Votre site apparaîtra dans «Vos projets».

Image 8 : Accédez à vos bases de données avec phpMyAdmin.

Image 6 : Placez votre site dans le répertoire «www», ou cliquez 
dans le menu «www directory» pour y accéder directement.

Image 5 : 
Pour obtenir 

la langue 
française, 

cliquez 
sur le lien 

«version 
française».

Section Windows
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Section Windows

aviez-vous que, lorsque vous avez 
coché la case en forme de «S» 
avec «Install» au moment de l’ins-

tallation de X11 sous Cygwin (cf Open-
source-Magazine n°1), vous avez installé 
en même temps WindowMaker ? Eh oui!
Comment le lancer, me direz-vous ? Vous 
allez pouvoir vous servir à nouveau de ce 
fameux Cygwin, en faisant un double clic 
sur son icône. Vous allez avoir un Terminal 
qui va se lancer et vous allez pouvoir ren-
trer cette commande:
$ xinit.exe /usr/X11R6/bin/wmaker.exe
Et vous voilà  ainsi avec une autre inter-

face graphique de Linux. Cependant, 
il n’y a aucune évolution majeure pour 
Window Maker à l’inverse de KDE, Gno-
me ou encore Enlightenment.
Pour en revenir à Window Maker, le menu 
s’obtient avec un simple clic droit et vous 
pouvez naviguer à l’intérieur de celui-ci 
grâce à votre souris. Et, en regardant 
dans le menu Applications, vous remar-
querez Gimp, Abiword, Dia, OpenOffice, 
etc. Malheureusement, aucun de ces lo-
giciels n’est installé par défaut.
Par contre, vous pouvez lancer les logi-
ciels que vous avez pu installer comme 

FontForge (voir article) ou encore Scribus 
(voir article) à travers Window Maker.
Pour FontForge ouvrez un Xterm (clic 
droit) et rentrez la commande suivante :
/usr/local/bin/fontforge.exe
Il en sera de même avec Scribus, ouver-
ture d’un Xterm, et vous devrez rentrer 
cette commande :
/opt/scribus/1.2/bin/scribus.exe

Alx.

http://www.windowmaker.org/

ƒ  C’est la commande à rentrer dans Cygwin.

ƒ  Window Maker est bien, mais n’a pas vraiment évolué.

image 1

image 2

image 3

image 4 image 5

ƒ  Vous pouvez lancer Scribus depuis Window Maker.

ƒ  Window Maker fait partie de X11. ƒ  FontForge fonctionne très bien aussi.

S

WindowMaker
une interface minimaliste



WindowMaker



http://www.shrinkto5.com/

OpenSource Magazine / n° 3 / mars-avril 200628

ShrinkTo5
La copie privée de DVD sous Windows

ous avez acheté un DVD et 
vous souhaiteriez en faire 
une copie de sauvegarde, à 

usage strictement personnel. Vous 
voudriez aussi le faire sans avoir à 
débourser un seul centime et de 
surcroît avec un logiciel open sour-
ce pour Windows. Alors, ne cher-
chez pas plus loin, et découvrez, 
ShrinkTo5, sur ce site :

http://www.shrinkto5.com/

S’agissant d’un exécutable, voici la 
démarche à effectuer:
Faites un double clic sur ShrinkTo5.
exe qui vous ouvrira la fenêtre 
d’installation et cliquez sur «Next». 
Acceptez la licence et cliquez sur 
«I Agree».
Sélectionnez l’emplacement de 
ShrinkTo5 en C:\Program Files\
ShrinkTo5\Software\ et cliquez sur «Ins-
tall». Vous pourrez suivre l’évolution de 
l’installation par une barre verte.
Une fois l’installation terminée, une fenê-
tre apparaît comportant la mention déjà 
cochée «Run ShrinkTo5 GUI 1.7».
Décochez-le, vous en comprendrez la 
raison par la suite, et cliquez sur «Finish».
Mais si la curiosité l’emporte, vous pou-
vez tout de même lancer ShrinkTo5 et 
découvrir son apparence. Toutefois votre 
investigation s’arrêtera là, pour la simple 
et bonne raison que ce logiciel nécessite 
un fichier qui n’est autre que le célébris-
sime Machinist.dll. Celui-ci a pour objec-
tif de faire sauter les protections CSS des 
DVD. Et si, justement, il ne fait pas partie 

intégrante de ShrinkTo5, 
c’est son caractère illé-
gal dans certains pays. 
Donc à vous de voir en 
fonction de votre lieu de 
résidence si vous êtes ou 
non autorisé à l’utiliser. 

Malheureusement, ce fi-
chier est indisponible sur 
le site de l’éditeur. Ce ne 
sera donc que sur inter-
net ou mieux, les réseaux 
P2P que vous le trouverez. 
Sur ce point, il n’y a eu 
aucune difficulté avec 
Limewire. Un petit indice, 
il se trouve dans le dossier 

Release, 
en fonc-
tion bien évidemment de 
ce que vous récupérerez. 
Une fois en possession de 
Machinist.dll, vous allez 
le placer avec les autres 
éléments de ShrinkTo5 
en C:\Program Files\
ShrinkTo5\Software\, et 
vous serez en mesure de 
copier votre DVD sur vo-
tre ordinateur.
Lancez ShrinkTo5, et cli-
quez sur le drapeau fran-
çais pour changer la lan-
gue.

Section Windows

ƒ Image 0 : Machinist.dll est indispensable
au fonctionnement de ShrinkTo5

ƒ Image 1 : L’interface de ShrinkTo5
est très agréable.

ƒ Image 2 : Vous pouvez visualiser la copie
de votre DVD.

V

ƒ L’mage 3 : L’image a été copiée
avec succès.
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Etapes pour copier
un DVD sur votre ordinateur :

- Choisir le lecteur D:\ (ou autre) 
dans le premier rectangle
- Choisir l’emplacement où votre 
DVD va se copier dans le deuxiè-
me rectangle.
- Spécifier la taille du DVD, gé-
néralement il est par défaut à 
4.37Go, mais vous pouvez l’aug-
menter ou le réduire.
- Cochez ce que vous désirez: 
DVD complet ou personnalisé. 
Si vous en faites un personnalisé 
n’oubliez pas de cocher et dé-
cocher ce que vous voulez dans 
la partie gauche de la fenêtre.
- Appuyer sur la flèche verte.
- Finalement, votre fenêtre va 
se convertir en une plus petite 
en bas à droite et vous pourrez 
suivre l’évolution de la copie du 
DVD.
Vous allez avoir un message vous 
signalant que «l’image a été transcodée 
avec succès» et vous pouvez cliquer sur 
OK. 
Maintenant que la copie du DVD est pré-
sente sur votre disque dur, il ne vous reste 

plus qu’à la graver. Deux choix s’offrent à 
vous. Le premier est d’utiliser votre logiciel 
de gravure, et le second est d’utiliser la 
fonction de gravure intégré a ShrinkTo5. 
Il s’agit de l’icône «Burn it!».

Seulement voilà, l’élé-
ment qui vous permettra 
de graver est tout bonne-
ment, comme Machinist.
dll, absent.
De toute façon, vous vous 
en apercevrez vite car en 
cliquant sur «Burn it!», vous 
aurez un message en an-
glais vous signalant «We 
need your help».
Si vous voulez, en faisant 
une quelconque dona-
tion, non seulement vous 
assurez la survie de ce lo-
giciel, mais vous aurez en 
retour par email l’exten-
sion Machinist.dll, et aussi 
celle de FoxBurnerU.dll 
qui assure la fonction de 
gravure.
Mais si, avant de verser 
votre obole, vous voulez 
tester les capacités de 
ce logiciel et surtout voir 
si la gravure fonctionne, 
voici la démarche pour 
obtenir FoxBurnerU.dll. 
Fermez donc ShrinkTo5 
et connectez-vous à ce 
site :

http://www.foxburner.
com/foxburner/default.
asp 

Il s’agit du site officiel 
FoxBurner, mais vous pou-

vez aussi l’obtenir de façon plus directe 
à ce lien : 

http://www.torry.net/vcl/filedrv/cd/
foxburner38Net.exe

Il vous faudra installer ce logiciel, et lors-
que l’installation sera terminée, vous cli-
querez sur l’icône «Mon Ordinateur», puis 
le disque local (C:), le dossier des Pro-
grammes, le dossier FoxBurner, ensuite 
sur SDK, et pour finir le dossier Bin où vous 
trouverez le fichier FoxBurnerU.dll.
Un petit récapitulatif C:\Program Files\
FoxBurner\SDK\Bin\FoxBurnerU.dll.
Le mieux est de faire une copie de FoxBur-
nerU.dll sur votre bureau (Touche Control 
+ déplacement de la souris pour le co-
pier sur votre bureau).
Vous allez maintenant cliquer sur la flèche 
retour pour retourner au dossier des pro-
grammes et aller dans le dossier SkrinkTo5. 
Basculez le fichier FoxBurnerU.dll présent 
sur votre bureau à l’interieur de ce dossier 
(C:\Program Files\ShrinkTo5\Software\). 
Vous pouvez relancer ShrinkTo5 et vous 
serez alors apte à accéder a «Burn it!» 
et graver l’image que vous avez précé-
demment copiée sur votre disque dur.
Il s’agit bien évidemment d’une façon 
un peu détournée, mais cependant lé-
gal pour obtenir le fameux FoxBurner.dll. 
Mais tout de même, pensez à récom-
penser le travail des développeurs qui 
ont réalisé ShrinkTo5.

Alx.

http://www.shrinkto5.com/

http://www.limewire.com

Section Windows

ƒ Image 4 : Déplacez FoxBurnerU.
dll dans le dossier de ShrinkTo5 pour 
accéder a la fonction de gravure.

ƒ Image 5 : Le graveur étant reconnu, vous pouvez 
copier votre film sur un DVD vierge.

ƒ Image 6 : La gravure peut débuter.



ous Comptes Faits Personnel édi-
té par Apacabar, Quicken d’In-
tuit ou encore Money de Micro-

soft sont des logiciels de gestions de 
dépenses personnelles. Gros inconvé-
nient... ils sont payants! Alors comment 
peut-on gérer ses comptes, sans avoir 
à investir dans un logiciel qui le fasse 
pour nous ? Et bien la réponse se trouve 
avec l’excellent Grisbi qui a d’ailleurs 
été évoqué dans un précédent nu-
méro (cf. N1 p. 51 et 52). L’article se 
consacrait à son installation sous Linux 
et Mac, du coup nous allons expliquer 
comment l’installer sous Windows. 
Grisbi est disponible en plusieurs lan-
gues dont le français et vous le trouverez 
à l’adresse suivante :
http://prdownloads.sourceforge.net/
grisbi4win/grisbi-0.5.7-win32-
gcc-050605-full.exe?download

Dès que l’exécutable est placé sur votre 
bureau, faites un double clic. Une fenê-
tre de dialogue vous demande d’effec-
tuer le  choix de la langue. Le français 
facilitera grandement la compréhension 
pour poursuivre sa mise en place. Cliquez 
sur OK. La fenêtre de 
bienvenue, plus gran-
de que la précédente, 
s’ouvre. Cliquez deux 
fois de suite sur «Sui-
vant». Acceptez les 
conditions en cliquant 
sur le cercle, puis sur 
«Suivant». Ensuite, vous 
avez le choix pour 
l’installation. Il est tout 
de même conseillé 
de faire une installa-
tion personnalisée et 

d’enlever les langues qui ne vous intéres-
sent pas, comme l’allemand, l’espagnol, 
etc… C’est toujours quelques Mo de ga-
gnés sur votre ordinateur. Vous trouverez 
ceci dans «Interface en...». Un clic de 
plus sur «Suivant» et il vous est demandé 

où vous souhaitez l’installer. Gardez l’em-
placement qui vous est donné en C:\
Program files\Grisbi et cliquez sur «Sui-
vant». Il vous demandera aussi de choi-
sir «un dossier dans le menu Démarrer», 
laissez tel quel et cliquez sur «Installer». 

L’installation terminée, vous pouvez faire 
un dernier clic sur «Suivant». Vous pouvez 
cocher «Lancer Gribi 0.5.7 maintenant»  
(si, si, il est bien écrit Gribi) ou simplement 
cliquer sur «Fermer». Mais si votre choix 
est de «fermer»,  vous devrez ouvrir cette 

application à partir du 
menu « Démarrer ». 
La mise en place de 
Grisbi est donc relati-
vement simple.
Lorsque vous le lance-
rez pour la première 
fois, il faudra aller dans 
le menu et cliquer 
sur « Nouveau fichier 
de compte ». Vous 
aurez le choix entre 
compte bancaire/
caisse/passif/actif. Il 
ne vous reste plus qu’à 
vous mettre à l’ouvra-

ge et entrer les données de vos/votre 
compte(s) comme les recettes, les dé-
penses et les autres mouvements divers 
et variés.

Alx.

Gérez vos comptes personnels

Section Windows

www.grisbi.org/index.fr.html

ƒ Supprimez les langues que vous ne souhaitez pas. ƒGrisbi est parfaitement bien installé.

ƒCliquez sur Nouveau fichier de compte pour
vous en servir. ƒ Faites votre choix parmi les types de compte disponibles.

ƒ L'interface : claire, simple et conviviale. ƒ En un coup d'œil, vous savez où vous en êtes dans vos comptes.

T
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Grisbi pour Windows
Créer des pages web



a création d’un site internet exige 
la plupart du temps un logiciel, ex-
cepté pour les plus expérimentés 

qui peuvent se permettre d’écrire des 
lignes et des lignes de codes aussi bien 
en HTML, PHP, ASP ou un autre langage, 
sans utilisation du Wysiwyg. Mais pour 
« l’apprenti », la chose est loin d’être 
aisée.  Cependant, pour les futurs web-
masters, il existe sur le marché un grand 
nombre de logiciels. Et vous avez le choix 
dans ce domaine car vous en trouverez 
des gratuits et des payants. Au rayon des 
gratuits, vous aurez Netscape Composer 
ou encore OpenOffice. Cependant, leur 
utilisation n’est pas des plus aisées et ne 
donne pas forcement entière satisfac-
tion. Puis, dans la section des payants 
vous retrouverez les incontournables 
GoLive, Dreamweaver ou encore Front-
page. Le problème, c’est qu’il va falloir 
justement payer le prix fort pour ces lo-
giciels, et ce n’est qu’après une longue 
période d’apprentissage que vous en 
tirerez la pleine quintessence. Si vous 
ne voulez rien dépenser et utiliser un lo-
giciel vraiment basique et particulière-
ment simple à manipuler, il vaut mieux 
s’orienter vers Nvu qui offre les éléments 
nécessaires pour construire un site. Seul 
inconvénient, il ne gère pas le PHP. Es-
pérons qu’il offrira cette possibilité dans 
un avenir proche. Parlons maintenant de 
son installation. En premier lieu, nous al-
lons sur le site de Mozilla pour en obtenir 
la version française pour Windows :
http://prdownloads.sourceforge.net/
frenchmozilla/
nvu-1.0-win32-installer-fr.exe?download

Une fois placé sur votre bureau, faites un 
double clic sur nvu-1.0-win32-installer-fr. 
Une fenêtre s’ouvre et vous pouvez cli-
quer sur «Suivant».  Il s’affiche alors l’ac-
cord de licence que vous acceptez en 
sélectionnant «Je comprends et j’ac-
cepte les termes du contrat de licence». 
Le bouton «Suivant» apparaît, et vous 
cliquez sur celui-ci.  Pour le choix de 
l’emplacement, gardez le même en C:\
Program Files\Nvu et cliquez sur Suivant. 
Puis vient la création du raccourci du 
programme dans le menu Démarrer.
Si vous ne le souhaitez pas, il vous suffit 
de cocher la case «Ne pas créer de dos-
sier dans le menu Démarrer», et un clic 
sur «suivant». Cochez la case si vous dési-

rez «Créer une icône sur le bureau» ou/et 
«Créer une icône dans la barre de lan-
cement rapide» et un clic sur «Suivant». 
Etes-vous «Prêt à installer»?
Il vaut mieux répondre «oui» sinon vous 
n’aurez jamais le logiciel. Et enfin, cli-
quez  sur «Installer». Lorsque l’installation 
arrive à son terme, cliquez sur «Terminer» 
et laissez cocher «Exécuter NVU» si vous 
désirez l’utiliser de suite. D’ailleurs, c’est 
ce que nous allons faire. Ainsi, une fenê-
tre va s’ouvrir et vous demandera si vous 
voulez signaler à NVU que vous utilisez 
leur programme. Libre à vous de cliquer 
sur OK ou Annuler. Puis une fenêtre sur 
les astuces de NVU s’affichera que vous 

pourrez décocher en cliquant sur 
le petit carré «Afficher les astuces au dé-
marrage». En tout, 18 astuces sont dis-
ponibles. Il ne vous reste plus qu’à créer 
votre première page index.html, d’y in-
clure le contenu (texte, images,…), de 
créer des liens vers vos autres pages et 
finalement, de diffuser votre création sur 
le réseau.

Alx

http://frenchmozilla.sourceforge.net/
nvu/
http://www.framasoft.net/article2656.
html (Tutoriel pour NVU)
http://www.nvu.com/

dans l’environnement Windows

Section Windows

ƒ Image 2. Voulez-vous signaler aux 
auteurs de ce logiciel que vous l’utilisez ?

ƒ Image 3. Créer une page avec NVU, c’est très simple.

ƒ Image 1. C’est parti pour l’instalation NVU.
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Créer des pages web



Site web

ne fois NVU pris en main, sans dou-
te souhaiterez-vous aller un peu 
plus loin. Nous allons répondre ici 
à quelques questions que tout 

créateur de pages se pose un jour. 

• Comment obtenir une page avec 
un fond coloré unifié ?
• Comment placer les textes et ima-
ges où bon vous semble dans la 
page ?
• Comment colorer une zone bien 
délimitée en largeur et en hauteur ?

Le premier outil à maîtriser est l’outil des 
couleurs. Situé dans la barre d’outils 
(Image 1), il permet d’affecter une cou-
leur soit au fond de la page, soit à une 
forme ajoutée à ce fond.
Pour modifier la couleur du fond, cliquez 
sur le carré blanc qui se trouve en par-
tie masqué par le carré noir. Une palette 
s’affiche. Sélectionnez le colori que vous 
pouvez améliorer à votre convenance. 
Aussitôt que vous avez validé, la couleur 
est affectée au fond.
Si vous cliquez sur le carré noir, vous pour-
rez modifier le colori des caractères du 
texte saisi dans cette page. 
De la même façon, vous pouvez colorer 

les différentes cellules d’un tableau dont 
la vertu est de pouvoir aligner correcte-
ment des textes ou des images.

A présent, comment placer un texte 
n’importe où dans la page ?

Il faut utiliser l’outil « Layer » (couche).
Dans un premier temps, saisissez le texte 
à déplacer. Peu importe l’endroit où 
vous l’inscrivez, il pourra ensuite être dé-
placé. Une fois le texte saisi et le curseur 
placé entre la première et la dernière let-
tre, cliquez sur l’outil Layer. Tout le texte 
est sélectionné dans un bloc qui dispose 
d’un carré supérieur dans lequel figure 
une quadruple flèche. En approchant 
le pointeur de la souris de ce carré, la 
flèche se transforme en main. Il ne vous 
reste plus qu’à déplacer le bloc où bon 
vous semble dans la page. Il ira s’ancrer 
là où vous le déciderez. Il pourra même 
chevaucher un élément déjà présent. 

Bien pratique pour placer une légende 
de photo sur la photo.
Grâce aux deux outils situés à droite de 
l’outil Layer, vous pouvez rapprocher ou 
éloigner chaque bloc par rapport à un 
autre et donc faire se chevaucher
plusieurs éléments.
Ce bloc pourra être coloré en utilisant les 
mêmes outils qu’employés pour le fond 
et les polices ce qui permet une vraie 
personnalisation de la page. Pour tes-
ter cette page, enregistrez-là et ouvrez-
la avec Safari, Firefox, Internet Explorer, 
etc. 
L’autre outil avec lequel vous pouvez 
jouer pour formater le texte est celui 
placé à gauche de la barre d’outils por-
tant la mention « Body texte ». Il permet 
de modifier le format et le style du texte 
selon d’autres critères que ceux affectés 
au texte par défaut. Cet outil est notam-
ment pratique pour afficher des titres en 
gras, des sous-titres, etc.

U

Maîtrisez la mise en page web

ƒ Image 1.

ƒ Image 5.

ƒ Image 2.
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Logiciel

i la fonction Exposé de Mac OS X vous 
fait baver d’envie, ne courez pas ache-
ter un Mac. Votre distribution Linux per-

met aussi de profiter d’un même système de 
rangement des fenêtres ouvertes et entassées 
en une palette de vignettes claire et facile à 
utiliser. Une fois Komposé installé par Synaptic 
ou Adept, il vous faut lancer Komposé (créez 
un lanceur) puis simplement cliquer dans l’icô-
ne apparue dans le tableau de bord en haut 
à droite. Un clic-droit sur cette même icône 
permet de dérouler le menu pour accéder aux 
différents réglages de cet utilitaire. Komposé 
fonctionne sous KDE mais aussi sous Gnome.
Il existe une alternative conçue pour Gno-
me : Skippy.
Firefox (1.4.1 et plus) propose égale-
ment une solution identique pour afficher les 
différentes pages ouvertes en onglets avec 
l’extension Viamatique foXpose. Une fois l’ex-
tension en place et Firefox relancé (voir Open-
source-Magazine n°1 p. 4 et 5), une nouvelle 
icône est installée en bas à gauche de la fenê-
tre du navigateur permettant d’afficher sous 
forme de vignettes toutes les pages ouvertes 
en onglet. Un clic sur la page permet de l’affi-
cher. Un outil indispensable.

http://kompose.berlios.de/

S

Comme Exposé d’Apple, Komposé range proprement les fenêtres en vignettes
sous KDE, comme Gnome.

Ranger les fenêtres
en planche contact

Komposé peut être paramétré
à votre convenance.

Clic-droit sur l’icône et le menu s’affiche.

Firefox propose sa propre fonction de rangement des pages en vignettes
avec Foxpose.
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Paramétrer le réseau pour

se connecter à internet
uelques lecteurs ont éprouvé des difficultés à l’heure de 
se connecter à internet depuis Ubuntu. Normalement, 
si votre ordinateur est connecté à un modem ADSL, 

Ubuntu est en mesure, lors de son installation, de paramétrer 
ses outils réseau sans votre intervention. 

Si d’aventure votre installation a eu lieu alors que votre ordi-
nateur n’était pas connecté à internet ou si Ubuntu a échoué 
dans le réglage du réseau, voici comment procéder pour acti-
ver la connexion après coup.

• Branchement par ethernet à un modem ADSL (ou à une borne wifi en réseau)

Branchez votre câble ethernet entre le modem ADSL et l’ordinateur. Déroulez le menu Sys-
tème >Administration>Réseau pour ouvrir le panneau des Réglages du réseau (image 1). Cli-
quez sur la ligne «Connexion internet : l’interface eth0 n’est pas configurée ». Cliquez ensuite 
sur le bouton Propriétés à droite. Cochez la case d’activation de la connexion et sélectionnez 
une Configuration par DHCP (image 2) pour que le modem attribue automatiquement une 
adresse IP au poste Ubuntu (image 3). Cliquez sur Valider. Quelques instants plus tard, votre 
connexion est normalement opérationnelle (image 4). Pour s’en convaincre, lancez Firefox 
et rendez-vous sur un site internet quelconque. S’il s’affiche c’est que vous êtes connecté. 
Vous pourrez dès lors ajouter les domaines de recherche pour mettre à jour votre Ubuntu (lire 
Opensource-Magazine n°1 p.10). 

Kexi&

Q

image 1

ƒOuvrez le panneau des réglages du Réseau
       et sélectionnez votre matériel.

ƒ La fenêtre des Propriétés permet d’activer la connexion
       par Ethernet et de choisir une configuration DHCP.

image 2

image 3 image 4

ƒQuelques secondes suffisent pour activer le réseau.ƒ Une adresse IP est attribuée automatiquement au poste.

Réseau
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• Branchement par modem

Cette fois, toujours dans le panneau de Réglages du réseau, cliquez sur « Connexion par modem » et affichez 
ses propriétés. Après avoir coché la case « Activer cette connexion », il faut inscrire le numéro de téléphone 
fourni par le fournisseur d’accès (image 5), et indiquer vos paramètres personnels de connexion (utilisateur ou 
login ou identifiant et mot de passe).
Dans l’onglet Modem (image 6), sélectionnez le port sur lequel est branché le modem, normalement sur le 
port de la prise téléphone /dev/modem. Vous pouvez aussi tenter votre chance en cliquant sur Autodétec-
ter. Il faudra aussi que votre modèle de modem soit reconnu par le système, ce qui ne sera pas forcément le 
cas.
Lorsque vous ouvrirez le navigateur internet, la connexion devra se lancer automatiquement.

• et avec KDE 

Si vous utilisez KDE (Kubuntu) plutôt que Gnome (Ubuntu), ouvrez 
depuis le menu K le panneau System Settings > Network Settings, 
entrez votre mot de passe après avoir cliqué sur le bouton du bas 
Administrator Mode. Cliquez sur la ligne Eth0 avec le bouton droit 
de la souris pour sélectionner le terme : Enable (image 7). Vérifiez 
au passage que la configuration (Configure Interface) est bien ca-
lée sur Automatique (DHCP) (image 8). Fermez la session et relan-
cez-la. Votre réseau sera pris en compte (image 9).

image 5

ƒ Indiquez le numéro de téléphone de votre fournisseur d’accès
       et les paramètres associés au compte.

ƒ Le principal écueil de la communication par modem est la non priseen 
charge de votre matériel.

image 6

ƒ Sélectionnez Enable dans le menu contextuel
       pour activer le réseau choisi.

ƒ L’indicateur vert confirme le bon fonctionnement du réseau.ƒDe la même manière, une adresse IP sera attribuée automatiquement à votre poste.

image 7

image 8

image 9

Réseau
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Installer de nouveaux logiciels
avec Adept sous Kubuntu

epuis le n° 1 d’Opensource-Ma-
gazine, nous avons largement fon-
dé notre propos sur la distribution 

gratuite de Linux appelée Ubuntu. Cette 
distribution de plus en plus populaire au 
regard de son extrême simplicité d’ins-
tallation et de mise en œuvre (un seul 
CD suffit) existe en plusieurs versions. La 
plus courante est la version « Gnome » 
dite Ubuntu. Elle s’appuie sur l’environ-
nement de bureau Gnome et permet 
d’installer tous les logiciels créés pour lui 
avec une grande facilité grâce à l’outil 
intégré Synaptic (cf Openource-Maga-
zine n°1 p.10).
L’autre grande variante d’Ubuntu s’ap-
pelle Kubuntu. Tout aussi gratuite et télé-
chargeable de la même manière depuis 
un site dédié, Kubuntu ne s’appuie pas 
sur l’environnement de bureau Gnome 
mais sur une autre célébrité : KDE. Si leur 
concept de base est proche, à savoir 
fournir une interface graphique et un 
gestionnaire de fenêtres simples à utiliser, 
il existe de notable variantes.
Ainsi, une fois Kubuntu installé, ce n’est 
pas l’outil Synaptic qui sert aux mises à 

jour de logiciels, mais Adept, situé dans 
le menu K>Système>Package Manager 
(Adept). Vous notez au passage que la 
traduction en français est moins poussée 
que pour Ubuntu.
Adept peut vous aider à installer de nou-
veaux logiciels, à moins que vous n’ayez 
vos petites habitudes avec Synaptic. 
Dans ce cas, nous allons utiliser Adept 
pour installer Synaptic...

De prime abord, Adept est nettement 
moins convivial que Synaptic (image 2). 
La première tâche est d’ajouter les sites 
de recherche de mises à jour de Kubuntu 
pour optimiser le système mais aussi récu-
pérer des logiciels non installés et main-
tenus par la communauté Ubunutu.
Déroulez le menu Adept>Manage Re-
positories. Si vous avez installé Kubuntu 
depuis le CD et que vous n’étiez pas 

connecté au réseau, la liste est longue 
mais une seule est activée (en noir). Il 
faut activer toutes les lignes ayant le 
Type : deb (première colonne). Cliquez 
sur chacune de ces lignes et affichez le 
menu contextuel avec le bouton droit 
de la souris (image 3). Sélectionnez : Ena-
ble (activer). Une fois que vous avez fait 
vos modifications, appuyez sur le bouton 
Apply en bas puis cliquez sur l’outil Fetch 
Updates situé dans la barre d’outils en 
haut.
Le catalogue des applications disponi-
bles se reconstruira et vous noterez que 
la liste a substantiellement augmenté. 
Si vous cliquez sur Full Upgrade, votre 
système sera mis à jour en fonction des 
nouveautés qu’il trouvera sur les sites de 
téléchargement ainsi ajoutés (image 4).
Cela peut prendre beaucoup de temps 
si vous avez installé Kubuntu depuis le CD 
sans connexion internet lors de l’installa-
tion.
A présent, pour installer Synaptic, saisissez 
ce nom dans le champ Quick Filter et va-
lidez avec la touche Entrée du clavier. 
Pour activer l’installation, utilisez le menu 
contextuel s’affichant avec le bouton 
droit de la souris, sélectionnez Install Pac-
kage (image 5) et cliquez sur l’outil Com-
mit Changes, en haut. Quelques instants 
plus tard, Synaptic est disponible dans le 
menu : K>Système>Gestionnaire de pa-
quets. Notez que vous pouvez détacher 
son icône pour aller la placer dans la 
barre d’outils située en bas de l’écran.
Vous pouvez à présent utiliser Synaptic 
pour installer de nouveaux logiciels ou 
vous contenter d’Adept.

www.kubuntu.org

D
ƒComme Synapic, Adept demande
       un mot de passe d’administrateur.

ƒAdept affiche les logiciels installés
       et ceux qui peuvent l’être.

ƒ Le menu contextuel permet d’ajouter
       un nouveau domaine de recherche
       de mises à jour.

ƒ La mise en jour du système provoque
       le téléchargement de nombreux fichiers.

ƒA l’aide du menu contextuel, validez
       les logiciels que vous souhaitez installer.

image 1

image 2
image 3

image 4 image 5

Kubuntu
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Installer de nouveaux logiciels
avec Adept sous Kubuntu

Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres

Livres Livres Livres Livres Livres Livres Livres Livres Livres

Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres

Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres

Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres

Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres Livres

€

ABONNEZ VOUS
PAR CARTE BANCAIRE

depuis notre site internet :
http://www.magazine-avosmac.com

22 numéros pour 65 euros,
soit 2 ans sans les Hors Série

Nom :
Prénom :
Adresse :

Code Postal :
Ville :
Pays :
E.mail :

Je m’abonne pour …… an(s) à 33 € (11 numéros)

Je souhaite que les Hors Série soient intégrés à mon abonnement
(pour les abonnés, il est possible de recevoir les Hors-série
sur simple demande par mail (avosmac@avosmac.com) , déduits à chaque parution)

44 € pour un abonnement de 1 an avec les hors-série (33 € pour 11 numéros sans les hs)

85 € pour un abonnement de 2 ans avec les hors-série (65 € pour 22 numéros sans les hs)

Je vous envoie un chèque de …… €  à l’ordre d’ AVOSMAC

JE NE VEUX PAS ME CASSER LE BONNET
ET J’OPTE POUR LE PRÉLÈVEMENT AUTOMATIQUE !
Bulletin à compléter et à renvoyer accompagné de votre relevé d’identité bancaire ou postal à :
AVOSMAC - Service Abonnements - La Favrière - 79 250 NUEIL-LES-AUBIERS - FRANCE

OUI, je souhaite recevoir «AVOSMAC» par prélèvement automatique mensuel (3,20 €)

Nom :
Prénom :
Adresse :

Code Postal :
Ville :
Pays :
E.mail :

Offre valable en France Métropolitaine pour un abonnement postal, interruption sur simple courrier ou mail : avosmac@avosmac.com

TARIFS INTERNATIONAUX
Vente au numéro

Belgique : 4,25 €
Suisse : 6,70 FS

DOM : 3,90 €
Nouvelle-Calédonie : 430 XPF

Polynésie : 450 XPF
Maroc : 36 MAD
Portugal : 4,30 €

Canada : 5,75 CAD
Île-Maurice : 4,60 €

Sénégal, Gabon, Cameroun,
Côte-d’Ivoire : 2800 CFA

A
U

TO
R

IS
A

TI
O

N
 D

E
 P

R
É

LÈ
V

E
M

E
N

T J’autorise l’établissement teneur de mon compte
à effectuer sur ce dernier les prélèvements
pour mon abonnement au magazine «AVOSMAC».

N° NATIONAL D’ÉMETTEUR
472361

Organisme créancier : SARL AVOSMAC
La Favrière - 79 250 NUEIL-LES-AUBIERS

TITULAIRE DU COMPTE À DÉBITER

Nom : 
Prénom :
Adresse :
Code Postal:                               Ville :

NOM ET ADRESSE DE L’ÉTABLISSEMENT DU COMPTE À DÉBITER

Adresse :
Code Postal:                               Ville :

Code d’établisse- Code Gui- Numéro de CléIMPORTANT : merci de joindre un relevé d’identité bancaire
ou postal, à votre autorisation.
Il y en a dans votre chèquier.

Date :

Signature :

ST
U

D
IO

 R
A

FF
I 0

6 
78

 4
03

 1
75

AVM60.indd   49 10/02/06   16:23:37

OpenSource Magazine / n° 3 / mars-avril 2006 37

s



Installer et activer les écha  nges FTP entre ordinateurs

Kexi&

utre la clé USB, un des moyens 
les plus pratiques pour échan-
ger des fichiers d’un ordi-

nateur à un autre, c’est le FTP (File 
Transfert Protocol). L’avantage de 
ce protocole d’échange de fichiers 
est que l’on peut faire « monter » sur 
le bureau local tout ou partie d’un 
poste distant. Ainsi, le poste distant 
apparaît sur le poste local comme 
s’il s’agissait d’un disque connecté 
ou d’un répertoire. Les fichiers peu-
vent passer d’un poste à l’autre en 
exploitant tout simplement le conte-
nu du répertoire en question.
Pour que cet échange fonctionne, il 
faut que le poste distant soit équipé 
d’un logiciel « serveur FTP » et que le 
poste local soit équipé d’un «client 
FTP ». Evidemment, si l’on souhaite 
que l’échange se fasse dans les 
deux sens, il faut les deux utilitaires 
sur chaque poste.

• Serveur FTP : Le plus facile à met-
tre en œuvre de notre point de vue, 
c’est Proftpd que Synaptic se fera 
un plaisir d’installer pour vous. Une 
fois en place, le serveur est mis en 
route. Pour vous en convaincre, 
ouvrez Système > Administration > 
Services et notez la présence du 
Service FTP (proftpd). La case doit 
être cochée si le serveur est en rou-
te (image 1).

• Client FTP : 

Si vous avez installé Ubuntu (ou 
Kubuntu), le client FTP est déjà inté-
gré au système. Pour vous connec-
ter au serveur FTP ci-dessus depuis 
un autre poste Linux, voici la mar-
che à suivre.

- sous Gnome (Ubuntu) : déroulez 
le menu Raccourcis > Se connec-
ter à un serveur pour ouvrir le pan-
neau Connexion au serveur. Dans 
Type de service, sélectionnez : FTP 
(avec identification) (image 2). Le 
champ Serveur devra être complé-
té par l’adresse IP du poste distant 
sur lequel tourne ProFTPd (image 3). 
L’adresse IP peut être connue en 
ouvrant le menu Applications > 
Outils système > Outils réseau et en 
sélectionnant l’outil réseau Ethernet 
interface (eth0) (image 4). Cliquez 
sur Connecter. 

O image 1

image 3

image 2

image 4

image 5

ƒ Le serveur ProFTPd est actif si la case
       est cochée.

ƒDans le panneau Connexion
       au serveur, sélectionnez
       la ligne FTP (avec authentification).

ƒAjoutez l’adresse IP du poste distant
       auquel vous souhaitez accéder.

ƒ L’adresse IP d’un poste Linux
       sous Gnome peut être connue
       avec l’outil Réseau.

ƒComplétez les champs
       de ce panneau d’identification
       du poste distant.

Transfert de fichiers
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Un répertoire portant des tubes en 
dessous est créé sur le bureau (ima-
ge 3 à droite). 
Double-cliquez sur ce dossier. 
Un panneau d’identification s’af-
fiche (image 5) dans lequel, après 
avoir coché la case « Se connecter 
en tant qu’utilisateur » vous rensei-
gnerez le champ utilisateur et mot 
de passe du poste distant.
Dans l’exemple, nous nous connec-
tons à un poste Macintosh sur lequel 
le serveur a été activé par les Préfé-
rences système > Partage (cocher 
Accès FTP) (image 6) et l’adresse IP 
a été relevée dans Préférences sys-
tème > Réseau > Ethernet > TCP/IP.

- sous KDE (Kubuntu) : déroulez le 
menu des configurations système 
pour sélectionner Emplacements 
distants. Dans le panneau qui 
s’ouvre, cliquez sur : Ajouter un dos-
sier réseau (baguette magique) puis 
cochez FTP pour signifier que vous 
souhaitez créer un service d’échan-
ge FTP (image 7). Après avoir cliqué 
sur Suivant, complétez les éléments 
identifiant le poste distant. 
Dans l’exemple, il s’agit toujours du 
poste Mac appelé « avosmac », à 
l’adresse 192.168.2.83 et pour le-
quel on compte exploiter le bureau 
(Desktop) de l’utilisateur avosmac 
(image 8). Ceci dit, comme précé-
demment, seul le champ serveur 
peut être renseigné.
A l’heure de se connecter il faudra 
renseigner le panneau en complé-
tant le champ Nom d’utilisateur 
(celui du poste distant) et son mot 
de passe (image 9). Vous ouvrez 
le poste distant dans le navigateur 
Konqueror (image 10).
Vous pouvez manipuler les éléments 
comme bon vous semble sans pou-
voir toutefois effacer à distance les 
fichiers du poste distant.

Les utilitaires : gFTP peut être utilisé 
pour communiquer entre deux pos-
tes des fichiers de la même manière 
qu’on l’exploite pour mettre à jour 
un site internet hébergé chez son 
fournisseur d’accès (cf Opensour-
ce-Magazine n°2).

image 6

image 7

image 8

image 9

image 10

ƒ

ƒAprès avoir cliqué
       sur la baguette magique, 
       cochez le choix : FTP

ƒ Entrez les coordonnées
       du poste distant.

ƒDonnez les éléments d’identification.

Vous naviguez à présent
dans le répertoire du poste distant.

ƒ

Un Mac intègre un serveur FTP qui 
s’active dans les Préférences système.

Transfert de fichiers



omment, depuis un Mac, se 
connecter à un poste sous Linux 
dans lequel le serveur FTPD a été 
activé ?

Il faut d’abord connaître l’adresse IP 
du poste Linux en utilisant l’outil réseau 
(Applications > Outils système > Outils ré-
seau sous Gnome). L’adresse IP dans le 
cas d’une liaison ethernet est accessible 
dans le menu déroulant : Périphérique 
réseau. Relevez l’adresse à six nombres 
selon le format : 192.168.2.2.
Cette adresse IP va servir à se connecter 
depuis le poste Mac. Sous Mac OS X, dé-
roulez dans le Finder le menu Aller > Se 
connecter au serveur puis entrez l’adres-
se IP du poste Linux, dans l’exemple :

ftp://192.168.2.2

Une nouvelle fenêtre s’affiche récla-
mant l’identifiant et le mot de passe du 
poste Linux distant. Renseignez ces deux 
champs et notez au passage que vous 
pouvez conserver dans le trousseau 
d’accès les données relatives à cette 
connexion.
Un disque de réseau apparaîtra sur le bu-
reau du Mac une fois la connexion éta-
blie. Vous pourrez naviguer à loisir dans le 
répertoire de l’utilisateur distant. 
Mais il est aussi possible de restreindre les 
droits d’accès depuis Linux et les limiter à 
un unique répertoire.
Pour modifier ces droits d’accès, il 
faut éditer depuis le terminal le fichier            
proftpd.conf de la sorte :

sudo pico /etc/proftpd.conf

et ajouter à la toute fin du fichier :

DefaultRoot ~/nom_du_repertoire

où nom_du_repertoire est l’endroit que 
vous souhaitez uniquement accessible 
depuis l’extérieur lors d’une connexion 
par FTP. Pour sauvegarder cette modi-
fication, combinez les touches CTRL-X, 
puis tapez O (pour oui) et validez. 
Il faut redémarrer le serveur FTP sur le 
poste Linux en entrant toujours depuis le 
terminal la commande :

sudo /etc/init.d/proftpd restart

Lorsque vous tenterez de vous connecter 
depuis l’extérieur, vous atterrirez aussi sec 
dans le répertoire défini dans ce fichier 
de configuration.

C
ƒ Le menu Aller > Se connecter au serveur, sert à établir la communication entre Mac et Linux.

ƒ Repérez l’adresse IP du poste Linux
       grâce aux outils Réseaux.

depuis un Mac

Transfert de fichiers

Se connecter à Linux
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epuis le n° 1 d’Opensource-Ma-
gazine, nous faisons un usage im-
modéré de la distribution Ubuntu 

qui a le mérite de la simplicité. Sa seule 
contrainte est qu’il est nettement préfé-
rable de disposer d’une connexion inter-
net, haut-débit si possible.
Ubuntu, livré sur un unique CD (gratuit 
avec un abonnement au magazine) a la 
faculté de se mettre à jour en fonction 
des nouveautés disponibles sur le net.

Pour installer Ubuntu, il faut insérer le CD 
d’installation (celui d’Opensource-Ma-
gazine a précisément cette vocation) 
dans votre Mac ou votre PC et de redé-
marrer. Pressez la touche C sur Mac pour 
forcer le redémarrage sur le CD.

Les différentes étapes d’installation se ré-
sument ainsi à l’apparition du bel écran 
tout bleu :

- sélectionner votre langue
- sélectionner votre emplacement géo-
graphique
- sélectionner votre clavier

L’installateur va alors tenter de détecter 
tous les composants matériels dont vous 
disposez et même configurer le réseau si 
vous êtes connecté (par éthernet sur un 
modem ADSL par exemple)

- donner un nom à votre machine (ubun-
tu par défaut)
- au chapitre des partitions, nous vous 
conseillons de choisir : « Utiliser intégrale-
ment le disque IDE1 maître (hda) », mais 
vous pouvez choisir autre chose si vous 
savez ce que vous faîtes. Tout l’espace 
du disque sera utilisé pour Ubuntu et les 
données contenues seront effacées.
- confirmer les règles de partitionnement 
définies, en vous plaçant sur OUI.

> après la réalisation des différentes par-
titions, l’installateur va procéder à la mise 
en place du système de base et des di-
vers paquets.

- accepter le téléchargement du sup-
port complet de votre langue si vous 
êtes connecté
- confirmer la « time zone » (Europe/Paris)
- donner un nom (ce nom n’a pas une 

grande importance)
- donner un nom d’utilisateur pour identi-
fier votre session par un login. Ce nom est 
très important. Faîtes simple.
- affecter un mot de passe (souvenez-
vous en par la suite, il vous sera indis-
pensable). Si vous entrez des chiffres, 
n’oubliez pas d’appuyer sur le verrouilla-
ge des touches numériques.
- confirmer le mot de passe en le reta-
pant 
- terminer l’installation en validant la der-
nière commande

> Ubuntu redémarre l’ordinateur, éjecte 
le CD d’installation et lance le système. 
Les paquets enregistrés depuis le CD 
vont être installés et téléchargés au be-
soin si vous êtes connecté (c’est la phase 
la plus longue).

- une fois la page d’accueil affichée, ins-
crivez votre identifiant et le mot de passe 
définis plus haut

En route vers l’aventure Ubuntu.

www.ubuntu-fr.org/telechargement

D

Voici les conventions propres à OpenSource Magazine utilisées dans certains articles. Nous vous demandons d’apprendre 

tout cela par cœur pour vous prémunir d’une interro surprise.

• : ne pas prendre en compte le gros point et le remplacer par un espace (barre d’espace).

<commentaire> : les indications placées entre <…> sont de simples commentaires destinés à l’utilisateur. Ils ne sont pas à 

intégrer au code, pas plus que les signes < et >.

La maison ou la petite maison : c’est le répertoire «home».

Il contient tous les éléments d’un même utilisateur. Cette maison (et son contenu) est ce que vous avez de plus précieux au 

monde. 

Le tilde ~ s’obtient en combinant les touches Alt-N puis espace

(Alt-ç sur     clavier QWERTY)

L’anti slash \ s’obtient en combinant les touches

Alt-Maj-/ (Maj-/ sur clavier QWERTY) 

Le pipe | s’obtient en combinant les touches Alt-Maj-L

(Alt-/ sur clavier QWERTY)

Pomme : il s’agit des deux touches frappées d’une pomme de part et d’autre de la barre d’espace, sur les claviers Mac.

Alt : ou touche Options existe aussi de part et d’autre du  clavier

Maj : ou touche Shift sur les PC, il s’agit de la touche avec laquelle on obtient des lettres majuscules. Elle  présente une flèche 

pointant vers le haut (à gauche du    clavier)

Répertoire = Dossier

Petite remise en mémoire

Installation de la distribution 
Linux  				    sur Mac et PC
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Ubuntu

V ous utilisez la version 5.04 d’Ubuntu 
depuis plusieurs mois et vous sou-
haitez à présent exploiter la toute 

dernière version, la 5.10. La mise à jour 
de la première vers la seconde est-elle 
possible sans perdre ses données person-
nelles ou faut-il procéder à une réinstalla-
tion complète ?

La réinstallation complète n’est pas obli-
gatoire. Téléchargez la nouvelle version 
d’Ubuntu sous forme d’image ISO de CD, 
puis gravez le CD de la nouvelle version. 
Une fois le CD prêt, insérez-le dans votre 
ordinateur (s’il n’était déjà présent dans 
votre machine). Il est aussitôt reconnu et 
un message en anglais vous invitant à 
procéder à la mise à jour. Cliquez donc 
sur le bouton « Automatically upgrade ». 
Synaptic, l’outil de gestion des paquets 
Debian se lance et met à jour sa base 
en fonction des nouveautés proposées 
sur le CD. Puis, il procède à l’installation 
des nouveaux éléments. Il y en à foison. 
Petite précaution, affichez dans Synpa-
tic la fenêtre de Terminal pour suivre le 
processus d’installation et surtout valider 
à chaque fois qu’une question vous est 
posée. Ce sera la réponse par défaut qui 
sera alors choisie et votre validation per-

mettra de poursuivre jusqu’à son terme 
la mise à jour.

Lorsque l’installation sera terminée, sans 
doute faudra-t-il ajuster la mise à jour de 
la langue française. Une fois que cette 
dernière opération sera effectuée, vous 
devrez relancer la session pour que les 
termes anglais disparaissent de votre en-
vironnement.

Il peut être nécessaire d’utiliser la com-
mande « Tout Mettre à Jour » de Synaptic 
(cliquez ensuite sur Appliquer) pour que 
la mise à jour frise la perfection.

Tout ceci expliqué, faut-il préférer une 
mise à jour réalisée de la sorte ou une 
installation « propre » en effaçant l’an-
cienne version après avoir sauvegardé 
ses données ? C’est cette dernière mé-
thode que nous privilégions systémati-
quement. 

Note : Pour vérifier la version installée 
dans votre ordinateur, déroulez le menu 
Système > A propos d’Ubuntu.

www.ubuntulinux.org/download/
http://f tp.oleane.net/pub/ubuntu-
cd/5.10/

Mettre à jour

ƒDéroulez le menu Système > A propos d'Ubuntu pour connaître la version installée.

ƒ Le nouveau CD est détecté automatiquement.

ƒ Le site Ubuntu.org permet de rapatrier la dernière version de cette distribution Linux.

ƒAffichez le panneau du Terminal
        pour pouvoir répondre aux questions.

ƒAu terme de l'installation, vous pourrez 
        réorganiser les paquets de langue.
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n souci pour lire le MP3 avec 
Rhythmbox ? Installer « Gstrea-
mer.mad » avec Synaptic (main-
tenu par les utilisateurs). Cet élé-

ment contient des décodeurs pour les 
fichiers MP3. Installé sans décodeur MP3, 
Rhythmbox ne peut lire que les fichiers au 
format Ogg Vorbis bien moins répandu.
Quitter Rhythmbox et relancer. Les fichiers 
MP3 pourront alors être lus et importés 
dans le lecteur de musique. Vous rendrez 
aussi bien service à Totem qui saura lui 
aussi lire les fichiers MP3.

Lire le MP3 avec Rhythmbox
U

ƒ Installez « Gstreamer-mad » pour lire les MP3 avec Rhythmbox.

ƒMême Totem est incapable de lire les fichiers MP3 sans un décodeur adapté.

Faites-le taire !
es sons joués à chaque action ont le 
don de vous mettre les nerfs en pe-
lote ? Qu’à cela ne tienne, dérou-

lez  le menu Système>Préférences>Son 
et modifiez les réglages des préférences 
son en décochant la case « Son pour les 
événements ». De même, c’est ici aussi 
que vous pouvez désactiver ou activer 
le serveur de son au démarrage. Si vous 
désactivez, vous n’aurez plus aucun son 
du tout, même celui des lecteurs de fi-
chiers musicaux ou de CD audio. Ça 
peut ne pas être très utile.

L

Décochez la case
        «Sons pour les événements »

        pour avoir la paix.

Rhythmbox

Son

ƒ



ne fois que vous avez pu tester synergyc et synergys 
avec succès (cf Opensource-Magazine n°1 p.18-19) 
pour l’échange d’un même pointeur de souris entre 

plusieurs écrans, vous avez la maîtrise de la chose. Sans doute 
voudrez vous à présent contrôler aussi efficacement le lance-
ment de synergyc et synergys autrement qu’en passant par 
une fenêtre de Terminal.

Sur Mac :
Vous pouvez créer une petite application sur la base d’un script 
de l’Editeur de scripts Apple en entrant la simple commande :

do shell script “ /synergys --config /synergy.conf ”

Il va de soi que le fichier de configuration aura été correcte-
ment paramétré. La mini application créée devra être glissée 
sur les Préférences système>Comptes>Ouverture pour être lan-
cée à chaque démarrage.

Sur Linux :
Depuis le menu Système>Préférences>Sessions, ouvrez le pan-
neau Sessions et cliquez sur l’onglet « Programmes au démar-
rage ». Cliquez sur Ajouter et entrez la commande :

synergyc <adresse IP du serveur synergy>

Foire aux questions

U

Comment rendre le lancement 
de Synergy plus facile ?

Si vous êtes un utilisateur de l’environnement Gnome, peut-être 
avez-vous été confronté un triste jour à l’impossibilité absolue 
de pouvoir lancer correctement votre session, stoppé net dans 
votre progression par un message sibyllin indiquant : 
«Votre session n’a même pas duré 10 secondes. Si vous ne vous 
êtes pas déconnecté vous même, cela peut siginifier qu’il y 
a des problèmes d’installation ou que vous êtes à cours d’es-
pace disque....»
Vous êtes certain que vous disposez d’assez d’espace disque 
et vous n’avez pas changé votre façon de démarrer votre ses-
sion. 
En regardant le détail de l’erreur, voici notamment ce qui est 
indiqué :

«Unable to read /home/votrelogin/.ICEauthority»

Ce bogue peut survenir et le résoudre impose de passer par le 
mode console (lignes de commandes). 

Une fois revenu à l’écran d’ouverture de la session où l’on vous 
demande d’ordinaire votre nom (login) et votre mot de passe, 
combinez les touches : CTRL-ALT-F1

A la ligne de commande, saisissez votre login puis votre mot de 
passe et entrez les commandes :

sudo chown votrelogin /home/votrelogin/.ICEauthority
sudo chgrp votrelogin /home/votrelogin/.ICEauthority

Il faut redonner votre mot de passe.
Lorsque cette opération s’est faite sans encombre, combinez 
les touches : CTRL-ALT-F7

pour revenir à la fenêtre de connexion. Renseignez les champs 
de connexion comme d’habitude. Vous pourrez normalement 
retrouver votre session sans perdre de données et surtout, sans 
avoir à réinstaller le système complet avec pertes et fracas.

Session bloquée

Sur Mac, vous pouvez programmer un script de lancement.

Le 
lancement 

au 
démarrage 
de Synergic 
ne présente 

aucun 
écueil.

La
réinstallation 

du système 
n'est pas 

nécessaire 
en dépit de 

ce blocage.
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force de multiplier les 
mots de passe, vient un 
jour où l’on court le risque 

d’en oublier un et de se trouver 
de facto complètement bloqué. 
Il existe une possibilité de regrou-
per tous les mots de passe diffé-
rents en même lieu protégé par 
un seul et unique mot de passe, 
à définir lors du premier enregis-
trement. Ce Fort Knox du mot de 
passe s’appelle le «Trousseau de 
clés par défaut» ou Porte-clés. 

Lorsque, à titre d'exemple, vous lancez une connexion 
FTP avec un autre poste, vous pouvez demander à 
conserver le mot de passe dans le Trousseau en co-
chant une simple case dans la boîte de dialogue.
Une fois ce mot de passe enregistré, vous n’aurez plus à 
vous en souvenir, seul le mot de passe du Trousseau sera 
requis pour activer la collection des mots de passe. 
Lorsque vous vous connecterez à nouveau, une fois le 
mot de passe du Trousseau entré, il vous sera possible 
d’autoriser l’accès au mot de passe du service FTP pour 
cette seule fois ou bien de toujours autoriser l’accès 
sans autre contrainte.

Astuces

A

La gestion
des mots de passe

le «Trousseau de clés par défaut»

Entrez le mot 
de passe du 
trousseau, et 
la collection 
de codes est 

disponible.

Après certaines mises à jour 
de votre système, il peut ar-
river qu’une petite ampou-

le s’affiche dans la barre 
supérieure des menus/outils 
en haut à droite de l’écran. 

Cette ampoule délivre des 
informations généralement 
de la plus grande importan-
ce. Lorsque vous mettez à 
jour le noyau Linux de votre 
distribution, c’est-à-dire lors 
d’une modification substan-
tielle des fondations de vo-
tre système d’exploitation, 
un message d’information 
vous invite à redémarrer 
sans délai.
Ce n’est qu’après avoir re-
démarré votre machine 
que de nouvelles mises à 
jour pourront avoir lieu de-
puis l’outil qui se trouve au 
bout de ce chemin :
Système > Administration 
> Gestionnaire de mises à 
jour.

Redémarrage urgent !

Outre la méthode 

«Subversion» présentée dans 
notre numéro 1 pour installer 
le nouveau gestionnaire de 
bases de données Kexi et 
surtout sa disponibilité dans 
Synaptic, il existe une autre 
solution : les paquets Debian.

Le logiciel et sa collection 
de librairies et autres 
dépendances, sont 
disponibles sous cette forme 
sur le site Debian.org mais 
nécessitent nettement plus de 
manipulations pour parvenir à 
un résultat identique.

L’affaire est donc réservée 
aux courageux !

Kexi
sous Debian

Un même mot de passe peut servir à gérer tous les autres.Chaque mot de passe peut être conservé
dans un trousseau.

Vous pouvez limiter 
l'usage d'un mot de 

passe à une seule 
opération, et le 

protéger à nouveau. En 
cliquant sur «Toujours 
autoriser», vous faites 

comme s'il n'y avait 
plus de mot de passe.

Comment rendre le lancement 
de Synergy plus facile ?
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i vous êtes un adepte ou un nou-
veau venu à la distribution Ubuntu, 
vous ne pouvez pas faire l’écono-

mie d’une visite au forum dédié à cette 
distribution Linux basée sur Debian. Ubun-
tu-fr est le point de rencontre de la com-
munauté francophone des utilisateurs 
d’Ubuntu. Ce forum technique et d’en-
traide est à Ubuntu ce que le célèbre site 
MacBidouille.com est au Mac. Sur place, 
l’internaute trouvera sans doute une ré-
ponse à ses questions, mais il pourra poser 
son problème auquel d’autres utilisateurs 
s’efforceront de répondre. Un seul regret, 
si les possesseurs de PC sont à la fête, les 
propriétaires de Mac auront un peu plus 
de soucis pour trouver des réponses adap-
tées. Par ailleurs, sa densité et la diversité 
des entrées pourraient bien nuire à sa clar-
té à terme.

http://forum.ubuntu-fr.org/

S

Forum Ubuntu en français

Si vous jugez que l’icô-
ne d’une application 
est trop petite (ou trop 
grosse), vous pouvez en 
modifier la taille grâce 
à un simple clic-droit sur 
l’icône en question. Une 
fois l’option «Redimen-
sionner l’icône» choisie 
dans le menu contex-
tuel, il ne reste plus qu’à 
utiliser les coins actifs 
pour faire grandir ou ra-
petisser l’image. 
Il va de soi que 
cette image 
devra supporter 
les agrandisse-
ments et donc 
être dans une 
résolution satis-
faisante.

Modifier la taille
des icônes

Error : XML Parser

Lorsque vous tentez de compiler les sources d’un logiciel 
libre depuis une fenêtre de terminal, il peut arriver que le 
message suivant s’affiche et que le processus s’arrête :

checking for perl... /usr/bin/perl
checking for XML::Parser... configure: error: XML::Parser perl 
module is required for intltool

Si vous comprenez un peu l’anglais, vous saisissez qu’il vous 
manque quelque chose.
Comment résoudre ce problème ?
Il faut installer le module libxml-parser-perl avec Synaptic. 

Est-il possible de faire
tourner un CD live d’Ubuntu
(ou de Kubuntu) sur Mac ?
L’opération ne présente aucun problème particulier. Pour les 
Mac équipés d’un microprocesseur G3, il faudra se rabattre 
sur la version 5.04 d’Ubuntu tandis que la version 5.10 tournera 
sans problème sur les Mac G4 et G5. 
Enfin, sans problème, c’est beaucoup dire. Si eMac et les Mac 
mini supportent sans souci et avec une assez bonne vélocité 
le CD Live de Kubuntu par exemple, un iMac G5 présente un 
caractère bien plus versatile vis-à-vis du CD qui doit obligatoi-
rement être lancé au démarrage par la commande :

live-power64

Une fois le système en cours de chargement, les ventilateurs 
du Mac montent à la puissance maximum pour ne jamais se 
calmer. La situation est aussi infernale qu’insupportable.

Si vous souhaitez rejoindre la communauté Ubuntu francophone,
rendez-vous sur le site Ubuntu-Fr.

La taille des icônes est 
aisément modifiable.
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our compresser un fi-
chier ou un ensemble 
de fichiers ou de réper-

toires, vous pouvez utili-
ser le bouton droit de la 
souris et vous servir de 
la commande «Créer 
une archive» disponible 
dans le menu contex-
tuel. Une autre solution 
peut consister à passer par une 
commande de terminal. 
La commande de compression 
au format zip est :

zip•-r•/fichierfinal•/fichierinitial

où /fichierinitial est le chemin 
complet qui conduit au fichier 

d’origine et /fichierfinal celui qui 
conduit au résultat compressé. 
Le nom peut être identique (le 
suffixe .zip est ajouté au fichier 
final).

Terminal

P

 Compresser
 depuis la console

Si vous avez l’habitude de tra-
vailler avec des fichiers au for-
mat PDF, vous pouvez souhaiter 
en extraire les images. 
Installez le logiciel xpdf (avec 
Synaptic) qui permet d’ouvrir 
les fichiers PDF. Lancez le termi-
nal et dans une fenêtre de la 
console entrez la commande :

pdfimages -j 

glissez à la suite de cette com-
mande votre fichier PDF et indi-
quez le lieu de destination des 
images. Par exemple :

pdfimages•-j•/home/
opensource/essai.pdf•/home/
opensource/fichier

enregistre les images du docu-
ment essai.pdf dans le réper-
toire de l’utilisateur Opensource 
en les nommant : fichier.

L’option “-j” permet la création 
de fichiers jpeg, la suite de ca-
ractères “fichiers” représente le 
début du nom des fichiers. Par 
exemple si le pdf contient deux 
images elles seront extraites 
dans des fichiers nommés “fi-

chier-000.jpg”, “fichier-001.jpg”.
Il y a ensuite quelques subtilités : 
“-f <nombre>” permet de spé-
cifier la première page que pd-
fimages va scanner et “-l <nom-
bre>” la dernière.

De plus lorsque vous avez instal-
lé xpdf vous avez obtenu par la 
même occasion “pdfinfo” :

pdfimage essai.pdf

Producer:    
pdfTeX-1.0-pdfcrypt
CreationDate :
Wed Nov 20 17:56:00 2002
Tagged :       no
Pages :        4
Encrypted :    no
Page size :   
595.276 x 841.89 pts
File size :    74918 bytes
Optimized :    no
PDF version :  1.3

Ce programme permet d’obte-
nir entre autre le nom du créa-
teur, la date de création et le 
nombre de pages d’un fichier.

Etienne Segonzac

Extraire les images 
des PDF

Imprimer avec le Terminal
Le Terminal offre une voie royale pour imprimer vite et 
bien. Il suffit d’entrer la commande :

lpr

puis de glisser/déposer le fichier à imprimer à la suite et 
enfin de valider. L’impression se lancera dans la foulée et 
utilisera l’imprimante définie par défaut dans le Centre 
d’impression (en ajoutant «-P» et le nom de l’impriman-
te, on change la destination). Cette solution présente 
l’avantage de pouvoir lancer de manière souple une 
session d’impression dans avoir à lancer l’application as-
sociée au document. En ajoutant «-#» suivi d’un nombre, 
on peut définir le nombre de copies à effectuer. Cette 
solution présente enfin un autre avantage : les marges 
sont réduites à leur plus simple expression.

Faites le parler
Vous souhaitez entendre votre ordinateur vous parler ? 
Qu’à cela ne tienne, installez depuis Synaptic la com-
mande Saytime. Une fois l’utilitaire installé, saisissez la 
commande :

saytime

dans une nouvelle fenêtre du terminal et écoutez. Le 
type à la voix nasillarde vous indiquera l'heure en an-
glais. Vous pouvez modifier les paramètres pour que le 
type vous fasse sa déclaration à intervalles réguliers, par 
exemple toutes les minutes (ce sera vite chiant). La com-
mande sera :

saytime -r 60

Pour faire taire le garçon, entrez la commande :

killall saytime

Vous pouvez également modifier le format de l’énoncé 
(lire la page du manuel : man saytime).

Dans le même esprit mais plus stressant encore, la com-
mande saydate (par Synaptic) annonce non seulement 
l’heure mais aussi le jour, le mois, la date, etc. Amusant.

Le sed tu déjà ?
La commande sed, permet d’explorer le contenu d’un 
fichier contenant du texte et de remplacer certains mots 
par d’autres. Exemple. Vous avez rédigé une lettre écrite 
à votre patron Duchemolle pour qu’il consente enfin 
à vous augmenter. Manque de bol, à peine avez vous 
terminé la missive que vous apprenez le changement 
de patron, remplacez illico par Legland. Qu’à cela ne 
tienne, voici la commande à entrer au Terminal pour 
remplacer aussi dans votre courrier Duchemolle par Le-
gland : 

sed•“s/Duchemolle/Legland/g”•/Users/opensource/
Desktop/MonCourrier.txt

La lettre g placée en fin de commande permet de rem-
placer toutes les occurences. Sinon, seul le premier Du-
chemolle sera remplacé par Legland. 
Pour vous facilier la tâche, ne cherchez pas le chemin 
de votre fichier, contentez-vous de le glisser vers la fenê-
tre de Terminal à la suite de la commande.
(rappel : le gros point noir est à remplacer
par un espace)

Le menu contextuel du bouton droit 
permet de compresser des fichiers.
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Il n’aura fallu que quelques semaines à 
l’éditeur Eyrolles pour sortir un ouvrage 
consacré à la nouvelle mouture d’Ope-
nOffice.org. Cette suite bureautique a 
franchi un pas si important avec cette 
nouvelle version qu’il n’y a plus de raison 
objective de ne pas s’y intéresser, voire 
de ne pas l’adopter tant sa compatibili-
té avec les documents créés sous Office 
de Microsoft est importante.
Le livre paru dans la collection Accès Li-
bre est écrit par ceux-là mêmes qui sou-
tiennent le projet en France : Sophie Gau-
tier (responsable du projet fr.openoffice.
org) , Christian Hardy, Frédéric Labbé 
et Michel Pinquier avec la contribution 
d’Eric Bachard et de Laurent Godard. 
Cette fine équipe a mis toutes ses 
connaissances au service du plus grand 
nombre et les royalties du livre au profit 
du club des utilisateurs de StarOffice et 
d’OpenOffice.org, l’association CUsoon 
(cusoon.org).
Livré avec un CD contenant la version 
2.0 pour Mac OS X, Linux et Windows, 

«OpenOffice.
org efficace» 
brosse un ta-
bleau le plus 
large possible 
des différents 
modules de 
la suite : Calc, 
Writer, Im-
press, Draw et 
Base. Autant dire que cet ouvrage à qui 
il ne manque que la couleur, sera une 
mine d’informations pour le nouveau 
venu à cette suite. Et ils sont nombreux 
au rythme où entreprises, associations et 
administrations migrent vers cette suite 
bureautique gratuite. 
De l’installation à la configuration du lo-
giciel, du maniement des feuilles de style 
aux macro commandes, de la prise en 
main du tableur (feuilles de calculs) à la 
création d’une présentation diaporama 
en passant par la génération de PDF 
et la gestion de bases de données, les 
auteurs n’ont rien négligé. Le tout est ex-
posé dans un style clair appuyé par de 
très nombreuses illustrations.

Livres

• Gimp 2
Livré avec un CD conte-
nant la version 2.2.7 de 
The Gimp pour Mac, Win-
dows et Linux, l’ouvrage 
« Gimp 2 efficace : des-
sin et retouche photo » 
de Cédric Gémy per-
met de toucher du doigt 
une des applications 
essentielles du monde libre. La vocation 
de The Gimp, excusez du peu, est de 
concurrencer Photoshop d’Adobe. Au fil 
des versions et surtout depuis la 2.2, cette 
application open-source y parvient dans 
la plupart des domaines.
« Gimp 2 efficace » est un solide guide 
de prise en main d’une application qui 
nécessite tout de même quelques heu-
res d’assiduité. L’auteur aborde l’essen-
tiel pour non seulement s’en sortir mais 
aussi vraiment travailler avec ce puissant 
logiciel. Le livre couvre tout le spectre, 
de l’installation à l’impression ou la pu-
blication d’images sur le web. Même les 
scripts, domaine plus pointu, est abordé 
dans le pavé. 
368 pages - 29 €
 www.eyrolles.com

• Gimp 2,2
Austère, l’ouvrage « Gimp 2.2 : dé-
buter en retouche photo et gra-
phisme libre » est d’un triste à mou-
rir avec des photos toujours aussi 
peu accrocheuses quand il s’agit 
d’évoquer ce puissant logiciel de 
retouche d’image. Si Dimitri Robert, 
auteur de ce guide de 280 pages 
format moyen compte faire des 

émules, il lui faut faire des efforts pour sé-
duire le regard. Nul doute pourtant que le 
livre peut rendre de fiers services à celles 
et ceux qui ont déjà une petite maîtrise 
de The Gimp «équivalent libre et gratuit 
d’Adobe Photoshop ». 
Après un cours rapide sur l’installation de 
The Gimp sous Windows, Mac OS X et 
Linux, Dimitri Robert lance le lecteur dans 
ses premiers apprentissages avec une 
découverte des menus et de l’interface 
de l’application. 
Au fil des pages, l’utilisateur va être 
confronté à la gestion des calques (fa-
cile), aux outils de sélection (simple), à la 
gestion des couleurs (pas évident), avant 
d’aborder une dizaine de travaux prati-
ques.
Tarif : 12 €     www.editions-eyrolles.com

•«Firefox à 200%»
La messe semble enfin dite pour Internet 
Explorer de Microsoft. La navigateur li-
bre Firefox de la fondation Mozilla est en 
passe de gagner son pari. Utilisé par des 
dizaines de millions de personnes, Firefox 
est LE navigateur internet par excellence 
respectant à la lettre les normes du web 
et tournant surtout sur MacOS, Linux et 
Windows avec un égal bonheur. 
A mesure que Firefox gagne de nouveaux 
adeptes, les éditeurs se précipitent sur le 
créneau. O’Reilly propose un « Firefox 
à 200 % » dont l’ambition est de faire le 
tour de la question en 100 trucs, secrets 
et techniques. L’ouvrage écrit par Nigel 
MacFarlane nécessite quelques conais-
sances de base. On voit mal l’utilisateur 
lambda se plonger dans les 400 pages 
techniques et fort peu illustrées sans 
broncher. Pour les connaisseurs, « Fire-
fox à 200 % » est une bible pour, une fois 
les bases digérées, aborder les notions 
de sécurité, le développement de sites 
web, l’intégration des codes XML, SVG, 
XUL, SQL, etc.

Tarif : 35 €                  www.oreilly.fr

• OpenOffice.org2

•Thunderbird
Thunderbird (désormais disponible en 
version 1.5), logiciel de messagerie de 
la fondation Mozilla a droit aussi à un li-
vre dédié dans la collection Accès Libre 
chez l’éditeur prolifique Eyrolles. 
Logiciel libre et gratuit fonctionnant sous 
Mac OS X, Linux et Windows, Thunder-
bird propose une solide alternative aux 
autres solutions de messagerie électro-
nique. Il dispose d’outils permettant de 
gérer au mieux les spams et autres cour-
riers indésirables. L’ouvrage écrit par Da-
niel Garance épaulé par Anne-Laure et 
Dominique Quatravaux et préfacé par 
le président de Mozilla-Europe Tristan Ni-
tot, aide l’utilisateur à correctement pa-
ramétrer Thunderbird pour exploiter au 
mieux ces fonctions riches de filtrage. 
De même qu’il explique comment classer 
et retrouver avec succès un mail archivé 
de longue date (Thunderbird dispose 
d’une base aussi puissante qu’efficace), 
comment gérer ses contacts enregistrés 
dans le Carnet d’adresses inclus. Les 
auteurs ont également pris soin d’expli-
quer comment s’abonner aux fils RSS et 
aux fils de nouvelles. Le livre aborde aussi 
le chiffrage des messages par Enigmail.
Un CD contenant les versions pour Linux, 
Mac OS X et Windows accompagne 
l’ouvrage.

Prix : 15 € - 300 pages
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Bonnes adresses

OpensourceMac est un site qui répertorie quelques ap-
plications open-source disponibles pour MacOS X.
On y retrouve les incontournables Firefox, Abiword, 

Adium, Thunderbird, The Gimp, Inkscape, etc. Mais le site man-
que encore de contenu. Dommage aussi que l’auteur ne fasse 
pas référence à Fink qui permet d’installer une solide collec-
tion de logiciels open-source sur Mac.

www.opensourcemac.org/

opensourcemac.org

V ous souhaitez suivre l’ac-
tualité du libre ? Plusieurs 
sites francophones sont 

tout entier consacrés à la com-
munauté des logiciels à l’instar 
de Framasoft évoqué dans le 
n°1 d’Opensource-Magazine.
LinuxFr.org est un autre site pha-
re de la communauté Linux en 
France. Ouvrant sur un fil d’ac-
tualités soigneusement sélec-

tionnées, préférant manifestement l’intérêt à la quantité (ce 
qui permet de ne pas être noyé sous une masse de nouvelles), 
LinuxFr.org propose une gamme de services si étendue que 
l’on s’y perd un peu. LinuxFr.org souffre d’une présentation 
austère qui conduit à rendre un peu nébuleux le fonctionne-

ment des différentes sections : Accueil et Dépêches (donnent 
les mêmes informations), Archives (comme le nom l’indique), 
Proposer une dépêche (il faut être inscrit, mais c’est gratuit), 
Journaux (discuter d’un sujet), Forum (technique et aide en li-
gne), Astuces (il y en a des centaines), Suivi et RDF (affiche les 
titres récents de dizaines d’autres sites).
Outre des liens vers les principaux éditeurs s’intéressant au sujet 
du libre (O’Reilly, Eyrolles, Linux France, etc) vous trouverez des 
liens vers d’autres sites internet consacrés en France à Linux et 
pourrez consulter enfin l’agenda du libre avec les prochains 
événements programmés ici et ailleurs dans le monde libre.
Attention, notez bien l’adresse du site (Linuxfr.org) car Linux.fr 
tout court donne un tout autre résultat.

http://linuxfr.org

linuxfr.org

Meebo n’est pas un logiciel mais un site 
internet qui offre les mêmes fonctions 
que l’utilitaire Adium, à savoir la possi-

bilité de gérer plusieurs comptes de discussion 
en ligne mais aussi plusieurs services (AIM, Ya-
hoo, MSN, etc). Si vous possédez un compte 
AIM et un compte Hotmail utilisé avec MSN, 
vous pouvez gérer les deux en même temps 
depuis la page d’accueil d’enregistrement de 
Meebo.com.
Le service est gratuit. Si Meebo présente enco-
re des bogues d’affichage des lettres accen-
tuées désagréables, il facilite la vie en cela 
qu’il est possible de tchater depuis n’importe 
quel poste, même s’il n’est pas équipé d’un 
logiciel de discussion en ligne. Un simple na-
vigateur internet tels Safari, Firefox, Opera ou 
encore Internet Explorer, suffit. Certes, les fonc-
tions sont pour l’instant fort limitées puisqu’il 
n’est pas possible de changer son pseudony-
me ni de gérer son compte et encore moins 
d’utiliser une webcam. Mais la compatibilité 
entre Mac, Linux, Windows est parfaite.

www.meebo.com

meebo.com
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GlobeTrotter
e GlobeTrotter est un disque dur 
externe USB de marque Lacie qui 
contient un système d’exploitation 

Mandriva Linux. Connecté sur un PC 
avant le démarrage, il permet d’utiliser 
Linux sans installation.

Avant la commande

Avant même de passer commande, sur-
prise et légère déception : bien que l’an-
nonce de la sortie du GlobeTrotter 2 ait 
eu lieu quelques jours après celle de la 
version 2006 de la distribution Mandriva, 
la distribution qui anime le GlobeTrotter 2 
est la version LE 2005.

Le GlobeTrotter 2 est disponible en deux 
versions : 40 ou 80 Go respectivement 
vendues 139 et 199 euros. Avant de com-
parer ce prix avec celui d’autres disques 
durs USB2, n’oubliez pas que celui-ci est 
un disque 2.5 pouces (à 5400 tr/min) (dis-
que dur d’ordinateur portable en fait) 
donc beaucoup plus petit et beaucoup 
plus cher que les disques durs portables 
3.5 pouces pour lesquels on trouve aisé-
ment des capacités de 200 Go à moins 
de 150 euros. Notez aussi qu’il n’utilise 
pas d’alimentation supplémentaire puis-
qu’il est alimenté par le port USB. Cha-
cun se fera donc une opinion sur le prix 
du giga-octet compte tenu des logiciels 
et services inclus.

Il est arrivé !

Quelques jours après avoir passé com-
mande, nous recevons un colis compre-
nant :
- Le disque dur.
- Un câble USB.
- Un deuxième câble est livré au cas où 
une seule prise USB ne puisse pas fournir 
la puissance nécessaire. Lors de nos tests, 
nous n’avons rencontré cette situation 
qu’une seule fois (avec un ordinateur 
portable), l’utilisation du deuxième câ-
ble a résolu le problème.
- Un CD contenant un bootloader (char-
geur de système d’exploitation) au cas 
où le bios de la carte mère ne soit pas 
capable de démarrer un système d’ex-
ploitation sur le port USB. Même sur les 
ordinateurs dont le BIOS affiche la pos-
sibilité de démarrer sur un périphérique 
USB, ce CD s’est avéré indispensable. Ce 
CD a aussi un rôle de restauration (nous 

n’avons pas testé cette fonctionnalité 
qui permet de ramener le disque dans 
son état d’origine.)
- Un livret intitulé «guide de démarrage» 
d’une trentaine de pages partagées en-
tre français et anglais. Une grande partie 
de ce manuel est consacrée à la confi-
guration au premier démarrage, l’utilité 
de cette partie nous semble discutable 
étant donné que les indications à l’écran 
sont en français et parfois plus complè-
tes que celles du manuel.
- Un dépliant de Lacie qui nous a semblé 
sans intérêt
- Un CD de Lacie. Il contient les drivers 
nécessaires pour utiliser un disque dur 
USB sous Mac OS 9, Windows 98 et 2000 
et quelques éxécutables pour Windows 
que nous n’avons pas testés. Il contient 
aussi une documentation en pdf qui sera 
d’un intérêt très limité pour les utilisateurs 
de Linux.
- Un feuillet donnant un code permet-
tant d’accéder aux services inclus dans 
l’offre.

Étant destiné à être transporté, nous 
aurions préféré que le GlobeTrotter soit 
livré avec une pochette de protection 
pour éviter les rayures et un boîtier plus 
solide qu’une pochette en papier pour 
transporter le CD de démarrage. Ceci 
dit, après plusieurs semaines de trans-
ports sans grand ménagement dans no-
tre sac l’aspect du disque dur reste im-
peccable.

Le CD de démarrage ne contenant que 
140 Mo de données, nous aurions préféré 
que celles-ci soient gravées sur un mini-
CD de 8cm (qui peut contenir jusqu’à 
210 Mo). Nous avons donc créé une 

image iso de ce CD que nous avons gra-
vée sur un mini-CD vierge. Un boîtier de 
mini-CD étant à peine plus large que le 
GlobeTrotter, l’ensemble est beaucoup 
plus pratique à transporter.

C’est parti !

Lors du premier démarrage, il est néces-
saire de répondre à un certain nombre 
de questions (langue, type de clavier, 
mots de passe...). Cette procédure res-
semble beaucoup aux dernières étapes 
d’installation d’une distribution Mandri-

va. Tous ces paramètres sont mémorisés 
une fois pour toutes.

En moins de 5 minutes le GlobeTrotter est 
opérationnel.

Contrairement à un Live CD, nous 
n’avons ressenti aucune lenteur exces-
sive lors du lancement d’applications. 
Vous pouvez modifier toutes sortes de 
choses dans votre configuration (fond 
d’écran, ordre des menus, configuration 
d’un client de messagerie...), ces modi-
fications seront conservées après redé-
marrage ou même lorsque vous utiliserez 
un autre ordinateur. 
KDE, Gnome et une assez grande quan-
tité de logiciels sont déjà installés. Le 
GlobeTrotter contient aussi quelques lo-
giciels propriétaires : Flash et Acroread 7 
sont installés par défaut.

Une partition de 5 Go contient le systè-
me. Une autre partition de 5 Go montée 
en lecture seule dans /mnt/packages 
contient un grand nombre de paquets 
qui ne sont pas installés. Il est donc pos-
sible d’installer d’autres logiciels sans dis-
poser d’une connexion à Internet. 500 
Mo sont consacrés au swap. Enfin, le res-
te du disque dur est divisé en deux par-

ƒ  Le disque dur et son CD de démarrage.

ƒ  Configuration initiale.

Une autre manière de transporter son système Linux
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GlobeTrotter

titions de tailles égales : l’une formatée 
en ext3 pour les données des utilisateurs 
(/home); l’autre formatée en fat32.
Si le GlobeTrotter est branché sur une 
machine fonctionnant sous Windows, 
seulement cette dernière partition ap-
paraît. Le GlobeTrotter se comporte alors 
comme une clé USB ou un disque dur 
USB «normal». Sur une machine fonction-
nant sous Linux toutes les partitions sont 
accessibles.

Pour le reste le GlobeTrotter s’utilise com-
me n’importe quel PC sous Mandriva LE 
2005 : le Mandriva Control Center (MCC 
pour les intimes) permet d’installer et sup-
primer des logiciels, créer plusieurs utilisa-
teurs, configurer une imprimante... Toutes 
ces modifications seront encore effec-
tives après redémarrage. Ceci est bien 
plus confortable que les Live CD pour 
lesquels il faut par exemple configurer le 
réseau à chaque démarrage.

A l’usage, il s’avère que la conservation 
des réglages du système est assez bien 
faite. Par exemple, le fond d’écran est 
conservé quelle que soit la machine 
alors que le profil matériel (la résolution 
de l’écran par exemple) est spécifique à 
une machine.
Pour faire une mise à jour, un assistant 

propose de choisir un miroir. Deux clics 
plus tard, le Centre de Contrôle Man-
driva suggère une mise à jour de plus de 
500 Mo ! On voit ici un nouvel avantage 
du GlobeTrotter sur un Live CD : le systè-
me peut être mis à jour.
Nous ne nous étendrons pas ici sur le sup-
port matériel : le fait que tel ou tel pé-
riphérique ait fonctionné correctement 
sur nos machines n’est pas forcément si-
gnificatif. En tous cas, après avoir testé le 
GlobeTrotter sur 7 machines différentes, 
nous n’avons rencontré aucun problème 
bloquant.

En fonctionnement, le disque dur ne 
chauffe presque pas, ne fait quasiment 
pas de bruit et vibre peu.

Le système de fichiers NTFS est supporté 
(nous n’avons testé que la lecture). Il est 
donc possible d’accéder aux données 
contenues sur les disques des ordinateurs 
que vous utilisez même s’ils sont habituel-
lement animés par Windows XP.

A votre service

L’offre du GlobeTrotter inclut un mois 
d’accès au services suivants que l’on ac-
tive en se rendant sur http://my.mandriva.
com.
- Mandriva Online : ce service peut vous 
prévenir par mail ou afficher une icône 
sur votre bureau qui change de couleur 
lorsque des mises à jour sont disponibles 
pour votre système.
- Mandriva Club (niveau «Silver») : Ce ser-
vice permet de télécharger des versions 
normalement payantes de la distribution 

Mandriva Linux et de la documentation, 
d’accéder à des forums...
- Support web illimité : vous avez la possi-
bilité de poser des questions aux techni-
ciens Mandriva via un formulaire web.

Conclusion

Le GlobeTrotter apporte une solution in-
termédiaire entre le Live CD et l’ordina-
teur portable.
Il permet d’aller bien au delà de «l’effet 
démo» d’un Live CD. Nous l’avons utilisé 
avec succès sur différentes machines 
pour faire de «vraies choses construc-
tives» telles que rédiger cet article ou 
créer un CV. Par rapport à un Live CD 
utilisé avec une clé USB, il est plus rapide 
et permet de stocker une grande quan-
tité de données, de conserver en mé-
moire les paramètres de configuration et 
d’installer, supprimer et mettre à jour les 
logiciels de la distribution. Cette solution 
permettra donc aux personnes se dépla-
çant souvent de retrouver partout leurs 
données et logiciels à un prix bien moin-
dre que celui d’un ordinateur portable. 
L’inconvénient par rapport à ce dernier 
est bien évidemment que l’on ne peut 
pas utiliser le GlobeTrotter dans les trans-
ports en commun et qu’il faut être sûr de 
trouver un ordinateur là où l’on va ! Avec 
le GlobeTrotter, nous avons rapidement 
eu l’agréable sensation que chaque or-
dinateur était un peu le nôtre.

F. M.

Mandriva Store :
http://store.mandriva.com/

ƒ  Installation de logiciels.

ƒ  Mise à jour du système.
ƒ  MandrivaOnline indique que le système
        doit être mis à jour.

ƒ  MandrivaOnline indique que le système
        est à jour.
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Passez commande sur la boutique AVM
http://boutique.avosmac.com


